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1

Product Components and 
Capabilities 1

The PATROL for Microsoft Windows Clustering Getting Started guide 
provides information and instructions necessary for using the PATROL 
for Microsoft Windows Clustering components (also referred to as 
PATROL for Windows Clustering). This chapter provides a brief 
overview of PATROL for Windows Clustering and covers the following 
topics:

What Is PATROL for Microsoft Windows Clustering?  . . . . . . . . . . . 1-2
PATROL for Windows Clustering Components. . . . . . . . . . . . . . . . . 1-2

PATROL KM for Cluster Server Features . . . . . . . . . . . . . . . . . . 1-3
PATROL KM for Cluster Server Applications and Icons  . . . . . . 1-4
PATROL KM for Network Load Balancing Features . . . . . . . . . 1-6
PATROL KM for Network Load Balancing

Applications and Icons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7
PATROL Cluster Configuration Wizard Features . . . . . . . . . . . . 1-9

Related Documentation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-10
Where to Go from Here . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-11
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What Is PATROL for Microsoft Windows 
Clustering?

With the PATROL for Microsoft Windows Clustering (PATROL for 
Windows Clustering) components, you can monitor and manage 
elements of your cluster server environment. Your cluster server 
environment can include the following platforms:

• Microsoft Windows NT Server 4.0, Enterprise Edition
• Microsoft Windows XP Professional
• Microsoft Windows 2000 Server
• Microsoft Windows 2000 Advanced Server
• Microsoft Windows 2000 Datacenter Server
• Microsoft Windows .NET Server–Standard, Enterprise, or Datacenter 

Edition

PATROL for Windows Clustering monitors the following elements in 
your cluster server environment:

• Microsoft Cluster Server
• Microsoft Network Load Balancing (NLB)

PATROL for Windows Clustering Components

The PATROL for Windows Clustering components are Knowledge 
Module™ (KM) components that manage and monitor elements of your 
cluster server environment. A KM is a set of instructions that the 
PATROL Agent uses to monitor objects in your enterprise. For 
modularity and convenience, these features have been grouped into 
smaller component pieces that can be installed and loaded independently.

PATROL for Windows Clustering contains two KM components, and a 
wizard to help you easily set up PATROL to monitor and manage your 
cluster server environment. The three PATROL for Windows Clustering 
components are
BMC Software, Inc., Confidential and Proprietary Information
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• PATROL Knowledge Module for Microsoft Cluster Server (PATROL 
KM for Cluster Server)

• PATROL Knowledge Module for Microsoft Network Load Balancing 
(PATROL KM for Network Load Balancing)

• PATROL Cluster Configuration (PCC) Wizard

These PATROL for Windows Clustering components will often be 
referred to individually throughout this book because you can use one or 
more depending on your environment.

PATROL KM for Cluster Server Features

The PATROL KM for Cluster Server component monitors, analyzes, and 
manages activities of a Microsoft Cluster Server (MCS) and its 
associated nodes, groups, resources, and services. The PATROL KM for 
Cluster Server allows you to obtain the current status of all essential 
cluster objects and perform cluster operations from a central point, which 
includes monitoring of

• all clusters in a domain
• individual clusters
• cluster communication networks
• cluster network interfaces
• cluster nodes
• cluster objects and resources
• cluster groups
• workload data
• group resources
• quorum device

For more information on specific functionality that supports these 
features see the PATROL KM for Cluster Server KM online Help.
BMC Software, Inc., Confidential and Proprietary Information
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PATROL KM for Cluster Server Applications and Icons

Table 1-1 contains information about the PATROL KM for Cluster Server 
applications and icons.

Table 1-1 PATROL KM for Cluster Server Applications and Icons

Icon and Name Description

MCS_Clusters

MCS_Clusters is a base application class for all clusters, and it 
contains parameters that report the status and availability of the 
cluster services.

MCS_Cluster

MCS_Cluster is a container for cluster components. It contains 
parameters that monitor the status and availability of each cluster.

MCS_Collectors

MCS_Collectors is a container for all KM collectors and general 
parameters. The parameters monitor all cluster objects and 
resources, and also the availability of debug and configuration files.

MCS_Group

MCS_Group is a container application class for MCS_Groups. It 
does not have any InfoBox items, menu commands, or parameters.

MCS_Groups

MCS_Groups is an instance container for all cluster groups and 
related status parameters.
BMC Software, Inc., Confidential and Proprietary Information
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MCS_Group_Resources

MCS_Group_Resources is an instance container for all cluster 
resources belonging to a specific cluster group and contains 
related status parameters.

Resource application instances, and the icons representing them, 
appear under MCS_Groups application instances. Icons for 
physical disk resources and file share resources are displayed as 
follows when the large icons view is activated.

This icon represents physical disk resources.

This icon represents file share resources.

Other types of cluster resources are represented by default 
Microsoft icons.

MCS_Networks

MCS_Networks is an instance container for all networks and 
related status parameters.

MCS_Network_Interfaces

MCS_Network_Interfaces is an instance container for all network 
interfaces used by a cluster and contains related status 
parameters.

MCS_Nodes

MCS_Nodes is an instance container for each member node 
running the cluster service. The parameters provide node status 
and monitor for keyword matches within the cluster log file.

Table 1-1 PATROL KM for Cluster Server Applications and Icons

Icon and Name Description
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PATROL KM for Network Load Balancing Features

The PATROL KM for Network Load Balancing component provides a 
central point for monitoring and administrating Microsoft Network Load 
Balancing clusters and nodes through the PATROL Console. It monitors 
and manages load balancing of Internet/intranet traffic across 
Microsoft Network Load Balancing cluster nodes. The PATROL KM 
for Network Load Balancing allows you to obtain the following 
information:

• status of the NLB cluster
• status of nodes within the NLB cluster
• cluster-related events
• cluster performance data

For more information on specific functionality that supports these 
features, see the PATROL KM for Network Load Balancing online Help.

MCS_Performance

MCS_Performance is a container for performance-related 
parameters that monitor the workload of cluster nodes.

MCS_Quorum

MCS_Quorum is a container for the cluster quorum device and 
contains related status parameters.

Table 1-1 PATROL KM for Cluster Server Applications and Icons

Icon and Name Description
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1-6 PATROL for Microsoft Windows Clustering Getting Started



PATROL KM for Network Load Balancing Applications and 
Icons

Table 1-1 contains information about the PATROL KM for Network 
Load Balancing applications and icons.

Table 1-2 PATROL KM for Network Load Balancing Applications and Icons

Icon and Name Description

LBS_Clusters

LBS_Clusters is the base application class for all network load 
balancing (NLB) clusters. This application class is a container for 
all NLB clusters that were added to the PATROL Console. The 
LBS_Clusters application class provides the following features:
• reports the number of NLB clusters being monitored on the 

network
• reports the number of active NLB nodes being monitored on the 

network
• provides a list of monitored NLB clusters from which you can 

select the clusters you no longer want to monitor
• allows you to manually enter the IP Address or name of a cluster 

you want to monitor

LBS_Cluster

LBS_Cluster is the base application class for each network load 
balancing (NLB) cluster. This application class provides monitoring 
and management functions for each individual NLB cluster. The 
LBS_Cluster application class provides the following features:
• displays cluster status (OK, Warn, Alarm)
• displays a list of monitored NLB nodes that are members of the 

current cluster
• allows you to configure port rules for the entire cluster (port rules 

must be consistent for all nodes in the cluster)
• suspends cluster operations on all monitored nodes
• drains all ports, then stops cluster operations on all monitored 

nodes
• resumes all suspended ports on all monitored nodes
• starts cluster operations on all monitored nodes
• allows you to enable or disable multicast support for all 

monitored nodes (all cluster nodes must operate in multicast or 
unicast mode)

• allows you to manually add or remove nodes for monitoring by 
the KM
BMC Software, Inc., Confidential and Proprietary Information
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LBS_Events

LBS_Events is a subclass of LBS_Cluster. This application class 
provides information about WLBS events in the Microsoft Windows 
Servers System Log. The parameters in this application class show 
the number of events that have occurred for Error, Warning, or 
Information. The LBS_Events application class provides the 
following functions:
• reports the total number of WLBS errors recorded in the 

Windows 2000 System Event Logs for all monitored nodes of a 
cluster and alarms if an error event is received

• reports the total number of WLBS warnings recorded in the 
Windows 2000 System Event Logs for all monitored nodes of a 
cluster and displays a warning if a warning event is received

• reports the total number of WLBS information events recorded in 
the Windows 2000 System Event Logs for all monitored nodes of 
a cluster

LBS_Node

LBS_Node is the base application class for each node within a 
network load balancing (NLB) cluster. The LBS_Node application 
class provides the following functions:
• displays node status (OK, Warning, Alarm)
• alarms if a node does not respond to a ping request
• provides WMI status

LBS_Performance

LBS_Performance is a subclass of LBS_Node. This application 
class contains node-performance parameters and provides the 
following functions:
• displays the percentage of page file usage and alarms when the 

percentage exceeds a threshold
• displays the amount of physical memory currently available on 

the node
• displays the percentage of total physical memory available on 

the node
• displays total CPU usage percent for all processes running on 

the current node and alarms when the percentage exceeds a 
threshold

Table 1-2 PATROL KM for Network Load Balancing Applications and Icons

Icon and Name Description
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PATROL Cluster Configuration Wizard Features

The PATROL Cluster Configuration Wizard provides an easy-to-use 
interface that allows you to configure the PATROL Agent for failover in a 
Microsoft Cluster Server environment. While guiding you through the 
process, the wizard collects the required configuration data and updates 
the system environment to integrate the PATROL Agent into the cluster. 
Configuring the PATROL Agent for failover support allows you to record 
history data for a clustered application in the same history database. This 
feature prevents you from having to reconcile the two different history 
files that are normally created when an application is failed-over from 
one node to another.
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Related Documentation

For additional information about PATROL for Windows Clustering, see 
the online Help for the component of interest, and the PATROL for 
Microsoft Windows Servers Release Notes. For information about the 
PATROL for Windows Clustering parameters, see the component online 
Help or the PATROL Parameter Reference Manual. For additional 
information about PATROL, see the following documentation:

• PATROL Console for Microsoft Windows User Guide, Volume 1
• PATROL Console for Microsoft Windows User Guide, Volume 2
• PATROL Console for Microsoft Windows User Guide, Volume 3
• PATROL Console for Unix User Guide
• PATROL Central Operator - Microsoft Windows Edition Getting 

Started
• PATROL Central Operator - Web Edition Getting Started
• PATROL Agent Reference Manual
• Help for your PATROL Console

To view the complete PATROL documentation library, visit the support 
page on the BMC Software Web site at 
http://www.bmc.com/support.html. Log on and select a product to access 
the related documentation. (To log on if you are a first-time user and have 
purchased a product, you can request a permanent user name and 
password by registering at the Customer Support page. To log on if you 
are a first-time user and have not purchased a product, you can request a 
temporary user name and password from your BMC Software sales 
representative.)

The complete PATROL documentation library is also available on the 
PATROL documentation CD included with major releases of the 
PATROL Console and Agent.
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Where to Go from Here
The following table suggests topics that you should read next:

If you want information about See

how to install PATROL for Windows Clustering Chapter 2, “Installing and Migrating PATROL for 
Windows Clustering”

how to load and configure the PATROL KM for 
Cluster Server or PATROL KM for Network 
Load Balancing using the PATROL Console

Chapter 3, “Loading and Configuring PATROL for 
Windows Clustering KMs”

how to use the PCC Wizard to help you 
configure the PATROL Agent for failover in a 
Microsoft Cluster Server environment

Chapter 4, “Using the PATROL Cluster 
Configuration Wizard”

how to use the PATROL for Windows 
Clustering KMs, and detailed descriptions of 
the applications, menu commands, and 
InfoBoxes

• PATROL KM for Cluster Server online Help or
• PATROL KM for Network Load Balancing online 

Help

parameter descriptions and defaults • PATROL KM for Cluster Server online Help or
• PATROL KM for Network Load Balancing online 

Help or
• PATROL Parameter Reference Manual

accessing menu commands, InfoBoxes, and 
online Help

Appendix A, “Accessing Menu Commands, 
InfoBoxes, and Online Help” 

PATROL Agent configuration variables Appendix B, “Agent Configuration Variables” 
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2

Installing and Migrating PATROL for 
Windows Clustering 2

This chapter provides the information that you need to install PATROL 
for Windows Clustering. For additional information about the PATROL 
installation process, see the PATROL Installation Reference Manual. The 
following topics are discussed in this chapter:

Verifying Installation Requirements. . . . . . . . . . . . . . . . . . . . . . . . . . 2-3
System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-3
License . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6
Account  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6
Port . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8

Preparing for Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
Determine the Version of the Installation Utility. . . . . . . . . . . . . 2-10
Target Computers and Their Roles  . . . . . . . . . . . . . . . . . . . . . . . 2-10
Determine Where to Install KMs Based on Architecture  . . . . . . 2-12
Typical and Custom Installation Types  . . . . . . . . . . . . . . . . . . . . 2-12
Selecting Components to Install  . . . . . . . . . . . . . . . . . . . . . . . . . 2-13
PATROL Cluster Configuration Wizard  . . . . . . . . . . . . . . . . . . . 2-15
Overview of PATROL KM for Cluster Server Installation  . . . . . 2-15
PATROL KM for Network Load Balancing  . . . . . . . . . . . . . . . . 2-18
Installing into the PATROL KMDS . . . . . . . . . . . . . . . . . . . . . . . 2-18
PATROL Security Levels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-18

Installing For the First Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-20
Upgrading from an Earlier Version  . . . . . . . . . . . . . . . . . . . . . . . . . . 2-23

Prepare to Upgrade  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-24
Upgrade Without Saving Customizations . . . . . . . . . . . . . . . . . . 2-25
Upgrade and Preserve Customizations  . . . . . . . . . . . . . . . . . . . . 2-32
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Migrate Your Customizations. . . . . . . . . . . . . . . . . . . . . . . . . . . .2-40
Creating and Installing Installable Images . . . . . . . . . . . . . . . . . . . . .2-45

Create an Installable Image  . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-45
Install the Created Installable Image  . . . . . . . . . . . . . . . . . . . . . .2-46

Installing the Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-47
Install Help into PATROL Central - Microsoft Windows Edition 2-47
Install the Unix Version of the Help Browser. . . . . . . . . . . . . . . .2-48

Using PATROL KM for Cluster Server at PATROL Security
Level 3 or 4  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-51

Uninstalling. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-53
Where to Go from Here  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2-53
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Verifying Installation Requirements
Before installing PATROL for Windows Clustering, verify that your 
environment meets the following requirements:

• system
• license
• account
• port

System

Verify that the target computer meets the installation requirements listed 
in Table 2-1.
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Table 2-1 System Requirements for Installing PATROL for Windows Clustering (Part 1 of 2)

Resource Requirements Comments

operating 
systems that 
run the 
PATROL 
Agent

• Windows NT Server 4.0, Enterprise 
Edition with SP5 or later

• Windows XP Professional
• Windows 2000 Server with SP1 or 

later
• Windows 2000 Advanced Server 

with SP1 or later
• Windows 2000 Datacenter Server 

with SP1 or later
• Windows .NET Server–Standard, 

Enterprise, or Datacenter Edition

• If your cluster-level agent is on Windows 
NT 4.0, you must install the Microsoft 
Cluster Server Administrator tools. After 
you install the Administrator tools, make 
sure that you reapply all service packs 
and hot fixes.

• The PATROL KM for Microsoft Network 
Load Balancing only supports Network 
Load Balancing clusters running on the 
following platforms: Microsoft Windows 
2000 Advanced Server and Datacenter 
Server, and Microsoft Windows .Net 
Server 2003 Standard Edition, 
Enterprise Edition and Web Edition. The 
PATROL KM for Microsoft Network Load 
Balancing does not support Windows 
NT 4.0 Load Balancing Service clusters.

• The PATROL KM for Network Load 
Balancing requires Windows 
Management Instrumentation (WMI) on 
all PATROL Agent machines used for 
monitoring NLB clusters. WMI is 
included with Windows 2000. If you are 
running Windows NT 4.0, you must 
install WMI. WMI will be installed during 
the PATROL installation if it is not 
already on the system.

• The PATROL KM for Microsoft Network 
Load Balancing requires Windows Script 
Host (WSH) version 5.0 or later on all 
PATROL Agent machines used for 
monitoring NLB clusters. WSH is 
required, at version 5.0 or later, because 
the PATROL KM for Microsoft Network 
Load Balancing uses encoded Visual 
Basic scripts to perform remote 
operations on nodes in an NLB cluster. 
WSH is included with Windows 2000. If 
you are running Windows NT 4.0, you 
must install WSH version 5.0 or later for 
the correct operation of the PATROL KM 
for Microsoft Network Load Balancing.

operating 
systems that 
run the 
PATROL 
Console

PATROL for Windows Clustering 
supports all BMC-supported operating 
systems that run the PATROL 
Console.
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applications 
managed by 
PATROL for 
Windows 
Clustering

• Microsoft Cluster Server
• Microsoft Network Load Balancing

PATROL for Windows Clustering supports 
the application versions that are shipped 
with the supported operating systems.

PATROL 
products

• NT_Base.kml from the PATROL KM 
for Microsoft Windows Operating 
System (Windows OS) 3.6 or later

• PATROL Agent 3.4.11 or later

One of the following consoles:
• PATROL Classic Console for 

Microsoft Windows–Developer 
3.4.11 or later

• PATROL Classic Console for 
Unix–Developer 3.4.11 or later

• PATROL Central Operator–Microsoft 
Windows Edition 7.x

• PATROL Central Operator–Web 
Edition 7.x

• The PATROL KM for Cluster Server is 
dependent on having the NT_BASE.kml 
loaded.

• The PATROL KM for Windows OS 3.8 or 
later is highly recommended. Without 
the PATROL KM for Windows OS 3.8 or 
later, you cannot properly configure 
some application classes such as 
NT_LOGICAL_DISKS.

disk space 
needed to 
install

82 MB This value is the maximum amount of disk 
space needed to install and it includes the 
disk space used by
• PATROL for Windows Clustering product 

files
• PATROL for Windows Clustering report 

templates for use with PATROL Adapter 
for Microsoft Office (PAMO)

These values do not include the disk 
space required by the PATROL Agent, the 
PATROL Console, and associated files.

browser Netscape Navigator 3.01 You need Netscape Navigator version 
3.01–4.78 to use online Help with the 
PATROL Classic Console for Unix. For 
information about installing and using 
Navigator to view the Help, see “Install the 
Unix Version of the Help Browser” on page 
2-48.

Table 2-1 System Requirements for Installing PATROL for Windows Clustering (Part 2 of 2)

Resource Requirements Comments
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License

Verify that you have a valid demonstration license (typically good for 30 
days) or a permanent license to run your PATROL products. If you have 
not yet installed a permanent license, contact your BMC Software sales 
representative or the BMC Software Contract Administration department 
for licensing information.

Account

This section describes how to set up a PATROL installation account for 
Windows platforms.

PATROL

PATROL requires a dedicated user account, known as the PATROL 
default account, in the Windows environment. The PATROL default 
account must be created before you install PATROL. The PATROL 
default account can be either a local or a domain account.

Stand-alone workgroup servers must use a local user account as a 
PATROL default account. Servers that are trusted members of a domain 
may use either a local or domain account. In each case, the PATROL 
default account must be a member of the local Administrators group of 
the computer where the agent will reside.

PATROL default accounts on domain controllers should be only domain 
accounts. The account on a domain controller must be a member of the 
domain Administrators group.
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Although you can use an existing Windows user account, BMC Software 
recommends that you create a separate Windows user account for 
PATROL.

Warning
Do not use a built-in Windows domain or local Administrator account as 
the PATROL default account. Such account usage causes files created by 
PATROL to be owned by the Administrator, which could result in 
security or file access problems.

PATROL KM for Cluster Server

The PATROL KM for Cluster Server uses a user-defined cluster account 
separate from the PATROL default account to connect to and manage a 
cluster. This account must have cluster administrative privileges. The 
PATROL MCS Monitor Service (McsService.exe) also runs under this 
account.

PATROL KM for Network Load Balancing Security Requirements

Specific security requirements are necessary for the PATROL KM for 
Microsoft Network Load Balancing For this KM to work successfully, 
the user account that you use with the PATROL Agent and PATROL 
Console must exist on the monitored computers or be a domain account. 
It is best to use this KM within a domain so that a domain account can be 
used for the PATROL Agent, the PATROL Console, and the monitored 
computers. Using this method, the user account does not have to be 
added to each computer.

This KM uses privileged operations, such as rebooting the operating 
system (OS) or stopping a service, to manage the monitored computers. 
All permissions and privileges are based on the user account used by the 
PATROL Agent. The privileges defined by your user account are 
duplicated by WMI so that only the information and actions you are 
allowed to perform are available on the monitored computer.
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For privileged operations, the PATROL Agent and PATROL Console user 
account must be part of the local Administrators group. For example, 
performing a remote shutdown requires that the remote shutdown 
privilege be granted to the agent and console user accounts. Members of 
the Administrators security group have this privilege by default.

Port

Unless you are doing a KM-only installation, you will be asked to 
specify a port number for connecting to all of the agent machines and to 
the Knowledge Module Deployment Server (KMDS).

The default port numbers are 3181 for agents and 3182 for the PATROL 
KMDS.

Preparing for Installation

BMC Software recommends that you first install PATROL for Windows 
Clustering on a limited number of development or test machines, then 
configure and test PATROL for Windows Clustering before installing it 
onto production machines.

Note
If you want to install a KM into the PATROL KMDS, do not launch the 
installation utility from the installation CD. See “Upgrade and Preserve 
Customizations” on page 2-32 for information about how to install into 
the PATROL KMDS.
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The installation utility installs only to a local computer. The installation 
utility cannot perform remote installations. You must install the PATROL 
KM for Cluster Server and a PATROL Agent locally on each cluster node 
and cluster-level agent that you want to monitor. (The cluster-level agent 
is the computer you designate to monitor the cluster.) You must install 
the PATROL KM for Network Load Balancing and a PATROL Agent on 
the computer you designate to monitor an NLB Cluster. You also must 
install PATROL for Windows Clustering and a PATROL Console locally 
on each computer from which you want to view results.

Note
The installation utility provides you with the ability to create an 
installable image of the products that you select during install. After you 
create the installable image, you can export it to a shared BMC Software 
directory to install the package on all computers that share the same 
BMC Software product installation directory, PATROL default logon, 
PATROL Agent port number, PATROL 3.x product directory, PATROL 
7.x product directory, and security option. For more information about 
creating and exporting installation packages, see “Creating and Installing 
Installable Images” on page 2-45.

Before you install, you must

• make sure you are using the appropriate version of the installation 
utility (page 2-10)

• understand target machines and their roles (page 2-10)

• determine where to install KMs based on architecture (page 2-12)

• choose between typical and custom installation options (page 2-12)

• select which components to install (page 2-13)

• understand how to install the PATROL KM for Cluster Server (page 
2-15)
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• (if you are using PATROL KMDS) learn how to install into the 
KMDS (page 2-18)

• choose among PATROL security options (page 2-18)

Determine the Version of the Installation Utility

The installation instructions contained in this version of PATROL for 
Microsoft Windows Clustering Getting Started pertain to version 7.3.10 
of the PATROL Installation Utility. This version of the installation utility 
might be different from the version included on another product CD or 
from a version that you downloaded from the BMC Software Electronic 
Product Download (EPD) site. If you use a version of the PATROL 
Installation Utility other than version 7.3.10, the instructions in this 
manual may not accurately describe what you see on your screen.

To determine the version of an installation utility, perform the following 
steps:

Step 1 Open a command prompt.

Step 2 Navigate to the directory where the installation utility is located.

Step 3 Enter one of the following commands:

• setup.exe -v (Windows) 
• setup.sh -v (Unix)

A message box displays the version of the installation utility.

Target Computers and Their Roles

The PATROL installation utility prompts you to select the roles 
performed by the computer that you are installing BMC Software 
products on (the target computer). Before beginning the installation 
process, review the following definitions of the roles that are presented in 
the installation utility and decide which of these roles is performed by 
each computer in your environment. 
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• Console Systems (also referred to as console computers) host user 
desktop applications such as consoles, user interfaces, viewers, and 
browsers. Select this option if the computer to which you are 
installing will perform any of the following roles:

— monitor and manage on Windows by using a PATROL Central 
Operator – Microsoft Windows Edition console (PATROL 7.x 
architecture)

— monitor, manage, and develop KMs on Unix by using a PATROL 
Console for Unix (PATROL 3.x architecture)

— monitor, manage, and develop KMs on Windows by using a 
PATROL Console for Windows (PATROL 3.x architecture)

• Managed Systems (also referred to as agent computers) host software 
that manages the resources on the computer, such as a Cluster Server, 
PATROL Agent, PATROL Knowledge Modules, and Service 
Reporting Retrievers. Select this option if the computer to which you 
are installing will perform any of the following roles:

— host a PATROL Agent 3.5 (works with both the PATROL 3.x and 
PATROL 7.x architecture)

— host KMs and components that contain the knowledge that 
PATROL uses to monitor the resources on this computer

• Common Services (new with PATROL 7.x architecture) hosts services 
that are shared among managed systems and console systems. You 
can install each of these common services on any computer in the 
network. Select this option if the computer to which you are 
installing will perform any of the following roles:

— host the PATROL Central Operator – Web Edition (PATROL 7.x 
architecture) Web server

— host the PATROL Console Servers

— host the RTservers
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For more information about these products, see PATROL Console 
Server and RTserver Getting Started, PATROL Central Operator – 
Web Edition Getting Started, and PATROL Central Operator – Web 
Edition online Help. 

Determine Where to Install KMs Based on Architecture

PATROL 3.x and PATROL 7.x architectures differ as to which target 
computers store Knowledge Modules and how much KM information is 
required by each type of system. During installation, ensure that you 
select the appropriate types of systems according to the following 
information:

PATROL 3.x

Install KM packages to Managed Systems and Console Systems. 

PATROL 7.x

For PATROL Central Operator – Microsoft Windows Edition, install KM 
packages to Console Systems, Common Services Systems, and Managed 
Systems.

For PATROL Central Operator – Web Edition, install KM packages to 
Common Services Systems and Managed Systems.

Typical and Custom Installation Types

The installation utility prompts you to select one of the following 
installation types: 

• Use the Typical installation type in any or all of the following 
instances:

— You are new to the product you want to install. 
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— You are performing a first-time installation (you are not 
upgrading).

Note
If you are installing PATROL for Windows Clustering to an existing 
PATROL Agent or Console environment, use Custom. Do not use 
Typical. Typical will overwrite your existing PATROL Agent and/or 
PATROL Console. 

• Use the Custom installation type in any or all of the following 
instances:

— You are upgrading PATROL for Windows Clustering from a 
previously installed version.

— You are installing into a PATROL 3.4.x environment.

Selecting Components to Install

Table 2-2 describes each PATROL for Windows Clustering component 
you can install. If you select the Typical installation type and the 
PATROL Adapter for Microsoft Office component, you automatically 
install the PAMO report templates that complement the KM component 
you choose. If you select the Custom installation type, you can install the 
PATROL Adapter for Microsoft Office, PAMO report templates, or both.
BMC Software, Inc., Confidential and Proprietary Information

Installing and Migrating PATROL for Windows Clustering 2-13



If you have a PATROL Agent installed on the computer where you are 
installing a PATROL for Windows Clustering KM component, the 
installation script designates the KM as preloaded in the agent 
configuration file. When a KM is designated as a preloaded KM on a 
PATROL Agent, it automatically loads and begins to monitor resources 
and applications whenever the agent is started. 

If you have a PATROL Console installed on the computer where you are 
installing a PATROL for Windows Clustering KM component, the 
installation script loads the KM into the console. 

Note
The KM components cannot preload unless you have a PATROL Agent 
or a PATROL Console installed on the target computer.

Table 2-2 Component Descriptions

Components Description What is Included

PATROL Cluster 
Configuration Wizard

Provides an easy-to-use interface that allows you to 
configure the PATROL Agent for failover in a 
Microsoft Cluster Server environment. PATROL for 
Microsoft Cluster Server does not require the PCC 
Wizard. However, to configure the PATROL Agent 
for failover in a Microsoft Cluster Server 
environment, you must install and run the PCC 
Wizard. 

PCC Wizard

PATROL Knowledge 
Module for Microsoft 
Cluster Server

• monitors the cluster as a unit and alarms when 
failover occurs

• allows a server to act as a cluster-level agent 
machine, which resides outside the cluster, to 
collect data from cluster nodes

• installs on at least one Windows 2000 Server in a 
clustered environment, which can include both 
Windows Advanced Server and Windows 
Datacenter Server

PATROL KM for 
Cluster Server

PATROL Knowledge 
Module for Microsoft 
Network Load Balancing

• monitors and balances TCP/IP connection loads 
across multiple ports and servers according to a 
configurable set of rules

• install on a Windows server that monitors remote 
computers, and for performance purposes, 
preferably not on an NLB node

PATROL KM for 
Network Load 
Balancing
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For more information about preloading, see the PATROL Agent Reference 
Manual.

PATROL Cluster Configuration Wizard

You can install PCC on any computer in the cluster domain. The target 
computer does not have to be a cluster node. The Cluster Administration 
Tools must be installed on the target computer.

Overview of PATROL KM for Cluster Server Installation

Install the PATROL KM for Cluster Server component only if you will 
monitor and manage Microsoft Cluster Server (MCS). 

Note
If you are upgrading from an earlier version of the PATROL KM for 
Cluster Server, review the information in “Migrate Your Customizations” 
on page 2-40.

The PATROL KM for Cluster Server uses a three-tier architecture as 
shown in Figure 2-1, and has components that you install inside and 
outside of a cluster. The PATROL KM for Cluster Server uses a 
cluster-level agent machine, which resides outside the cluster, to collect 
data from cluster nodes of all of the clusters you monitor.

Note
Use only one cluster-level agent to monitor one or more clusters. BMC 
Software recommends that you monitor up to ten clusters from one 
cluster-level agent for performance reasons. A cluster can be monitored 
by only one cluster-level agent.
BMC Software, Inc., Confidential and Proprietary Information

Installing and Migrating PATROL for Windows Clustering 2-15



Figure 2-1   PATROL KM for Microsoft Cluster Server Installation Summary

Before You Begin

Before you begin installing the PATROL KM for Cluster Server, you 
must 

• know the user name and password of the cluster administrator 
account

• have installed the Microsoft Cluster Administrator on the 
cluster-level agent machine

• have installed the PATROL KM for Windows OS, which preloads the 
NT_BASE.kml

• have reapplied all service packs and hot-fixes on the cluster-level 
agent machine on Windows NT 4.0 only (the necessary APIs are 
available on Microsoft Windows 2000 by default)

Node 1

Node 2

Cluster 2

Node 1

Node 2

Cluster 1

Install the PATROL KM for 
Microsoft Cluster Server here

Install the PATROL KM for

Cluster-level
agent machine

Machine running PATROL Console
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Install the PATROL
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Cluster Server, PATROL 

PATROL Agent here
Agent, and OS KM here

Install the PATROL 
KM for Microsoft
Cluster Server, PATROL
Agent, and OS KM here

Install the PATROL
KM for Microsoft
Cluster Server, PATROL
Agent, and OS KM here

Install the PATROL
KM for Microsoft
Cluster Server, PATROL
Agent, and OS KM here
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• have installed the PATROL Agent

Note
For each cluster, the cluster connection account (specified in the cluster 
administrator) must have the appropriate permissions and trusts to 
establish a session with the cluster. You can verify that the cluster 
connection account has the appropriate permissions by logging into the 
cluster-level agent with the selected account and connecting to the cluster 
with either the Microsoft Cluster Administrator GUI or the cluster.exe 
command-line tool.

For information about how the PATROL Agent supports an application in 
a cluster environment and what type of failover tolerance the agent 
provides, see the PATROL Agent Reference Manual.

Installation Process

The PATROL KM for Cluster Server installation process consists of the 
following tasks:

Warning
Do not install the PATROL KM for Cluster Server to a cluster virtual 
server.

1. Install the following components on each cluster node:

• PATROL Agent
• PATROL KM for Microsoft Cluster Server
• PATROL KM for Microsoft Windows OS 3.6 or later

Note
The PATROL KM for Windows OS 3.8 or later is highly recommended. 
Without the PATROL KM for Windows OS 3.8 or later, you cannot 
properly configure some application classes such as 
NT_LOGICAL_DISKS.
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2. Install the following components on each machine you plan to use as 
a cluster-level agent: 

• PATROL Agent
• PATROL KM for Microsoft Cluster Server

3. Install the PATROL KM for Microsoft Cluster Server on the machine 
that has your PATROL Console. This component can exist on the 
same machine as the cluster-level agent or a cluster node.

PATROL KM for Network Load Balancing

BMC Software recommends that the PATROL Agent has a network path 
to the load balance side of the Network Load Balancing cluster.

Installing into the PATROL KMDS

If you want to install PATROL for Windows Clustering into the PATROL 
KMDS, you must launch the installation utility from the command line as 
described in “Installing the New Version of PATROL for Windows 
Clustering If You Are Migrating Customizations Using the KMDS” on 
page 2-33.

PATROL Security Levels

You can secure the data passed between PATROL components and 
restrict unauthorized users from accessing your data by implementing 
PATROL security. PATROL now contains five security policy levels in a 
predefined set of security configurations that you can select from when 
you install PATROL.

Basic security (level 0) is a minimal level of security with no 
configuration requirements. At the highest level of advanced security (4), 
all communicating components must authenticate with each other and 
key databases must validate connection requests.
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High security requires more configuration of the communicating 
components (the agent and the console) and is more difficult to use than 
lower levels of security. You can select the security level that best 
balances the ease of use with your need for security.

All components in a system, including agents and consoles, must operate 
at the same level of security in order to communicate with each other. 
This requirement is ensured when you install PATROL with basic 
security (the default level of 0).

Review the security level definitions in the PATROL Security User Guide 
before installing PATROL to determine the appropriate security level for 
your system needs. If you want to implement a new security level after 
having previously installed PATROL security, see the PATROL Security 
User Guide for instructions.

For more information about implementing and using PATROL security, 
see the following documentation:

• PATROL Security User Guide
• PATROL Security Release Notes

How PATROL Security Affects the PATROL KM for Cluster Server

PATROL security is installed as part of the agent and console. KMs 
inherit the security policy from the agent and console on which they are 
installed. When PATROL security is set to level 3 or 4, the 
communication between the PATROL Agent and the PATROL KM for 
Cluster Server is disrupted. See “Using PATROL KM for Cluster Server 
at PATROL Security Level 3 or 4” on page 2-51 for more information 
and a workaround.
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Installing For the First Time

The PATROL Installation utility offers two types of installations: Typical 
and Custom. For a description of the two types of installations, please see 
“Typical and Custom Installation Types” on page 2-12. BMC Software 
recommends using the Typical installation type in the following 
situations:

• if you are installing for the first time into a managed system that does 
not contain a PATROL Agent or PATROL for Windows Clustering

• if you want to install PATROL for Windows Clustering for the first 
time to a console system

Note
By default, the Typical installation type configures the PATROL Agent to 
connect through port 3181. If you want to connect the agent from a 
different port, you must use the Custom installation type. See “Upgrading 
from an Earlier Version” on page 2-23 for instructions about using the 
Custom installation type.

Before You Begin

You first should install on a limited number of machines in the test 
environment, test the installation thoroughly, and then install in your 
production environment. 

To Install Using the Typical Installation Type

Step 1 From the installation CD or from an electronically downloaded 
installation (EPD) image, run setup.exe (Windows) or setup.sh (Unix).

Step 2 In the Welcome to the Installation Utility window, click Next to begin 
your installation.

Step 3 Review the license agreement, select Accept, and click Next to continue.
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Step 4 In the Select Installation Option window, select one of the following 
options:

• If you want to install the products without creating an installable 
image, select I want to install products on this computer now and click 
Next to continue.

• If you want to create an installable image that you can use to install 
the products on this computer and other computers later, select I want 
to create an installable image to be installed later, enter the directory 
where you want to store the installable image, and click Next to 
continue.

Note
If you select to create an installable image, all of the computers where 
you plan to use the installable image must share the same BMC Software 
product installation directory, PATROL default logon, PATROL Agent 
port number, platform, and security option. For more information, see 
“Creating and Installing Installable Images” on page 2-45.

Step 5 In the Select Type of Installation window, select Typical and click Next to 
continue.

Step 6 In the Specify Installation Directory window, accept the default directory 
and click Next to continue.

Step 7 In the Select System Roles window, select Managed Systems, Console 
Systems, Common Services, or all to indicate the components you want to 
install and click Next.

• Select Console Systems if you are installing to a computer that hosts 
or will host a PATROL Console.

• Select Managed Systems if you are installing to a computer that hosts 
or will host a PATROL Agent.

• Select Common Services if you are installing to a computer that hosts 
or will host the PATROL Central Operator – Web Edition (PATROL 
7.x architecture) Web server, the PATROL Console Servers, or the 
RTservers.
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Fore more information, see “Target Computers and Their Roles” on page 
2-10.

Note
For more information about the PATROL consoles, PATROL Console 
Server, or RT Server, see the PATROL Central Operator – Web Edition 
Getting Started and the PATROL Console Server User Guide.

Step 8 From the Select Products and Components to Install window, select the 
components that you want to install (see Figure 2-2 on page 2-22 and 
Table 2-2 on page 2-14) and click Next. 

Figure 2-2   Select Products and Components to Install Window–Typical Path

Step 9 In the Confirm BMC Startup Information window, select Yes or No to 
restart the PATROL Agent automatically and click Next:

• If you want the installation utility to restart the PATROL Agent after 
the installation is complete, select Yes. 

• If you want to restart the PATROL Agent after the installation is 
complete, select No.

Note
This window does not display if you are not installing into a managed 
system. 
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Step 10 In the Review Selections and Install or the Review Selections and Create 
Installable Image window, review the selections carefully to make sure 
they are correct.

• If you want to change your selections, click Back and make those 
changes. 

• If the selections are correct, select Start Install to start installing or 
Create Image to start exporting the image to the directory you entered 
in Step 4 on page 2-21.

A status window opens that contains current messages, current 
milestones and percent complete. 

Note
If you selected to create an installable image to install on several 
computers or on the local computer at a later time, see “Creating and 
Installing Installable Images” on page 2-45. 

Step 11 When the status window reports that the installation is 100% complete, 
click Next to view the results window. (Next does not appear until the 
installation is 100% complete.) 

Step 12 In the results window, click View Log to review the details of the 
installation or click Exit to close the installation utility. 

Upgrading from an Earlier Version
If you have a previous version of PATROL for Windows Clustering 
installed on the target computer, you have two options for upgrading to 
the new version of PATROL for Windows Clustering. Use Table 2-3 to 
help you choose an upgrade procedure.
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Whether you choose to save and migrate your KM customizations or not, 
the customizations you have made to agents and consoles are preserved 
and incorporated into the new version automatically. Only customizations 
to Knowledge Modules must be migrated.

Note
Throughout this section, all references to PATROL_HOME represent 
$PATROL_HOME in Unix and %PATROL_HOME% in Windows; all 
references to PATROL_CACHE represent $PATROL_HOME/patrol in Unix 
and %PATROL_CACHE% in Windows.

Prepare to Upgrade

Whether you are upgrading and migrating customizations or simply 
upgrading, you must first

• back up the current installation
• remove PATROL for Windows Clustering files from 

PATROL_CACHE

Back Up the Current Installation

Whether you are upgrading and migrating any customizations or simply 
upgrading, back up the current PATROL installation before starting to 
install. Follow these steps to back up the current installation:

Table 2-3 Choosing an Upgrade Procedure

Choose This Procedure If You Have This Situation

Upgrade Without Saving 
Customizations

• have not made any customizations to your previous 
version of PATROL for Windows Clustering

• want to overwrite your customizations with the default 
values of the new version of PATROL for Windows 
Clustering

Upgrade and Preserve 
Customizations

made customizations to your previously installed version of 
PATROL for Windows Clustering and want to save those 
customizations and migrate them to the new version of 
PATROL for Windows Clustering
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Step 1 Shut down any PATROL Agents, Consoles, and related services that are 
currently running. 

Step 2 Ensure that no one is accessing any PATROL files or directories. 

Step 3 Perform a full backup of the two directories where PATROL executables 
and data are typically stored. These directories are listed in Table 2-4.

Remove PATROL for Windows Clustering Files from PATROL_CACHE

You must remove the current PATROL for Windows Clustering files from 
the PATROL_CACHE directory for the console. If you do not, old product 
files in PATROL_CACHE are loaded instead of the newly installed files 
from PATROL_HOME.

Delete all PATROL for Windows Clustering files with the following 
naming patterns from PATROL_CACHE\knowledge and 
PATROL_CACHE\psl:

• MCS* (for the PATROL KM for Cluster Server)
• LBS* (for the PATROL KM for Network Load Balancing)

Upgrade Without Saving Customizations

Use this procedure in the following circumstances:

• you have performed the procedures in “Prepare to Upgrade” on page 
2-24

Table 2-4 PATROL Installation Directories to Back Up

Operating System Directory

Windows %PATROL_HOME% for agent and console installation directories
%PATROL_CACHE% for the console working cache

Unix $PATROL_HOME for agent and console installation directories
$PATROL_CACHE for the console working cache

Linux $PATROL_HOME for agent and console installation directories
$PATROL_CACHE for the console working cache
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• you want to install PATROL for Windows Clustering into an existing 
PATROL environment

• you want to install individual components

• you want to upgrade PATROL for Windows Clustering, but do not 
want to migrate existing customizations to PATROL for Windows 
Clustering

Step 1 If you are installing into PATROL 3.4.x in a Unix environment, follow 
these steps to start the installation utility. If you are installing into 
PATROL 3.4.x in a Windows environment or into PATROL 3.5 in a Unix 
or Windows environment, skip to Step 2.

1.A Open a command line prompt.

1.B Change to the drive where the installation CD is located.

1.C At the Unix command line prompt, enter
setup.sh -releaseversion v.r where v.r is the version of the 
PATROL environment into which you are installing.

1.D Skip to Step 3.

Step 2 From the installation CD or from an electronically downloaded 
installation (EPD) image, run setup.exe (Windows) or setup.sh (Unix).

Step 3 In the Welcome to the Installation Utility window, click Next to begin 
your installation.

Step 4 In the Review License Agreement window, review the license agreement, 
select Accept, and click Next to continue.

Step 5 In the Select Installation Option window, select one of the following 
options:

• If you want to install the products without creating an installable 
image, select I want to install products on this computer now and click 
Next to continue.
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• If you want to create an installable image that you can use to install 
the products on this computer and other computers later, select I want 
to create an installable image to be installed later, enter the directory 
where you want to store the installable image, and click Next to 
continue.

Note
If you select to create an installable image, all of the computers where 
you plan to use the installable image must share the same BMC Software 
directory, PATROL default logon, PATROL Agent port number, platform, 
and security option. For more information, see “Creating and Installing 
Installable Images” on page 2-45.

Step 6 From the Select Type of Installation Window, select Custom and click 
Next.

Step 7 In the Specify Installation Directory window, enter the correct 
information based on your installation scenario and click Next.

• If you are installing the PATROL Agent version 3.5 over the top of 
an existing installation, enter the directory path up to the PATROL 
product directory.

For example, if you want to install PATROL into D:\Program 
Files\BMC Software\PATROL3-4, enter D:\Program Files\BMC 
Software in the Specify Installation Directory window.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment on Windows, enter the directory path 
up to the PATROL product directory.

For example, if you want to install PATROL into D:\Program 
Files\BMC Software\PATROL3-4, enter D:\Program Files\BMC 
Software in the Specify Installation Directory window.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment on Unix, enter the full directory path 
to your previously installed products.
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For example, if you previously installed your PATROL products to 
/opt/patrol/PATROL3.4, you should enter /opt/patrol/PATROL3.4 in 
the Specify Installation Directory window.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment and you previously installed your 
existing PATROL products into a top-level directory (such as 
C:\PATROL3-4), enter the full directory path to your previously 
installed products.

For example, if you previously installed your PATROL products to 
D:\PATROL3-4, enter D:\PATROL3-4 in the Specify Installation 
Directory window.

The PATROL product directory is appended to the path that you enter in 
this step. You will specify the PATROL installation directory in Step 10 
on page 2-29. 

Step 8 In the Select System Roles window, select Managed System, Console 
System, Common Services, or all and click Next.

• Select Console System if you are installing to a computer that hosts or 
will host a PATROL Console.

• Select Managed System if you are installing to a computer that hosts 
or will host a PATROL Agent.

• Select Common Services if you are installing to a computer that hosts 
or will host the PATROL Central Operator – Web Edition (PATROL 
7.x architecture) Web server, the PATROL Console Servers, or the 
RTservers.

For more information, see “Target Computers and Their Roles” on page 
2-10.

Note
For more information about the PATROL consoles, PATROL Console 
Server, or RT Server, see the PATROL Central Operator – Web Edition 
Getting Started and the PATROL Console Server User Guide.
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Step 9 In the Select Products and Components to Install window, select the KMs 
that you want to install (see Figure 2-3 on page 2-29 and Table 2-2 on 
page 2-14) and click Next. 

Figure 2-3   Select Products and Components to Install Window–Custom Path

Step 10 In the Provide the PATROL 3.x Product Directory window, enter the 
directory where you want to install PATROL for Windows Clustering as 
appropriate for your installation scenario. This directory is appended to 
the base directory path that you entered in Step 7 on page 2-27.

• If you are installing the PATROL Agent version 3.5 over the top of 
an existing installation, enter only the PATROL product directory to 
which you want to install.

For example, if you want to install PATROL into D:\Program 
Files\BMC Software\PATROL3-4, enter PATROL3-4 in the PATROL 
3.x Product Directory window.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment on Windows, enter only the PATROL 
product directory to which you want to install.
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• For example, if you want to install PATROL into D:\Program 
Files\BMC Software\PATROL3-4, enter PATROL3-4 in the PATROL 
3.x Product Directory window.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment on Unix, do not enter anything. 
Delete any default inputs on this window.

• For example, if you previously installed your PATROL products to 
/opt/patrol/PATROL3.4, you must ensure that the PATROL 3.x 
Product Directory window is blank.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment and you previously installed your 
existing PATROL products into a top-level directory (such as 
D:\PATROL3-4 or /PATROL3.4), you must ensure that the PATROL 
3.x Product Directory window is blank. Delete any default inputs in 
this window.

Step 11 Complete the Confirm BMC Startup Information window:

11.A In the Specify the Current Agent Port Number field, enter the port 
number you want the PATROL Agent to use. The default is 3181. 

Note
If your previous installation used a different port number, change the 
default to the current port number for the PATROL Agent. 

11.B In the Restart the PATROL agent automatically? field, select Yes 
or No:

• If you want the installation utility to restart the PATROL 
Agent after the installation is complete, select Yes. 
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• If you want to restart the PATROL Agent after the 
installation is complete, select No.

Note
This window does not display if you are not installing into a managed 
system. 

Step 12 In the Review Selections and Start Install or in the Review Selections and 
Create Installable Image window, review the selections carefully to make 
sure they are correct.

• If you want to change your selections, click Back and make those 
changes. 

• If the selections are correct, select Start Install to start installing or 
Create Image to start exporting the image to the directory you entered 
in Step 4 on page 2-21.

A status window opens that contains current messages, current 
milestones and percent complete. 

Note
If you selected to create an installable image to install on several 
computers or on the local computer at a later time, see “Creating and 
Installing Installable Images” on page 2-45. 

Step 13 When the status window reports that the installation is 100% complete, 
click Next to view the results window. (Next does not appear until the 
installation is 100% complete.) 

Step 14 In the results window, click View Log to review the details of the 
installation or click Exit to close the installation utility. 
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Upgrade and Preserve Customizations

Use the appropriate procedure in this section if you want to upgrade to 
the new version of PATROL for Windows Clustering and you want to 
preserve any customizations you have made to the previous version of 
PATROL for Windows Clustering.

After you have finished this procedure, see “Migrate Your 
Customizations” on page 2-40 for instructions about incorporating your 
customizations into the new version. You should complete this process on 
a limited number of machines in the test environment first, test the 
merged KMs thoroughly, and then deploy them to your production 
environment. 

Note
To upgrade and preserve customizations, you must either migrate your 
customizations manually or use the PATROL Migration Tools version 3.5 
(no KMDS required), or have the latest version of KMDS installed as 
well as any available patches.

Determine Whether You Can Migrate

Before migrating customizations, you must determine whether or not the 
customizations to the previous version of PATROL for Windows 
Clustering that you have installed can be migrated to the new version of 
PATROL for Windows Clustering. See Table 2-5 to determine whether 
migration is supported for your current version of PATROL for Windows 
Clustering. If migration is supported, choose one of the following 
installation procedures to migrate your customizations:

• migrating customizations using the PATROL Migration Tools version 
3.5 (page 2-33)

• migrating customizations using the PATROL Migration Tools and the 
PATROL KMDS (page 2-33)
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• migrating customizations manually (page 2-35)

Installing the New Version of PATROL for Windows Clustering If You Are Migrating 
Customizations Using the PATROL Migration Tools Version 3.5

The process of migrating KM customizations from a PATROL 3.x 
environment to PATROL 3.5 no longer depends on the PATROL KMDS. 
Because the PATROL Migration Tools version 3.5 copy the new product 
files directly from the product CD rather than from KMDS, you do not 
have to install the new version of PATROL for Windows Clustering. Just 
ensure that the product CD is accessible when you are running the 
migration tools.

For specific instructions and detailed information about using the 
PATROL Migration Tools version 3.5, see the PATROL Migration Tools 
User Guide.

Installing the New Version of PATROL for Windows Clustering If You Are Migrating 
Customizations Using the KMDS

Note
Ensure that you have installed the latest version of PATROL KMDS, 
including any available patches.

If you want to install PATROL for Windows Clustering into the KMDS 
so that you can migrate the customizations that you have made to the 
currently installed version of PATROL for Windows Clustering to the 
new version of PATROL for Windows Clustering, you must follow these 
steps to run the installation utility in KMDS mode:

Table 2-5 Versions That You Can Migrate

Component Version

PATROL KM for Cluster Server 1.1.00, 1.1.01, 1.2.00, 1.3.00, 1.4.00, 
1.4.01

PATROL KM for Network Load 
Balancing

1.1.00, 1.1.01
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Step 1 Open a command line prompt.

Step 2 Change to the drive where the installation CD is located.

Step 3 Enter the correct command for your operating system (Table 2-6 
describes the command line options):

• At the Windows command line prompt, enter
setup.exe -kmds [-kmdsportnum portnum]

• At the Unix command line prompt, enter
setup.sh -kmds [-kmdsportnum portnum] [-releaseversion v.r]

The installation utility opens in KMDS mode.

Step 4 In the Welcome to the Installation Utility window, click Next to begin 
your installation.

Step 5 In the Review License Agreement window, review the license agreement, 
select Accept, and click Next to continue.

Step 6 In the Select Installation Option window, select one of the following 
options:

• If you want to install the products without creating an installable 
image, select I want to install products on this computer now and click 
Next to continue.

Table 2-6 Command Line Options for Installing in a KMDS Environment

KMDS Installation 
Options Description

-kmdsportnum portnum optional; use only if you are not using the default 
KMDS number 3182

-releaseversion v.r optional; use only if you are installing to a Unix 
PATROL 3.4.x environment. v.r designates the 
version number of the PATROL environment into 
which you are installing (for example, 
-releaseversion 3.4).
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• If you want to create an installable image that you can use to install 
the products on this computer and other computers later, select I want 
to create an installable image to be installed later, enter the directory 
where you want to store the installable image, and click Next to 
continue.

Note
If you select to create an installable image, all of the computers where 
you plan to use the installable image must share the same BMC Software 
directory, PATROL default logon, PATROL Agent port number, platform, 
and security option. For more information, see “Creating and Installing 
Installable Images” on page 2-45.

Step 7 In the Specify KMDS directory window, enter the full path to the 
directory in which the KMDS is installed and click Next.

Step 8 From the Select Products and Components to Install window, select the 
KMs that you want to install (see Figure 2-3 on page 2-29 and Table 2-2 
on page 2-14) and click Next. 

Step 9 In the Review Selections and Install window, review the selections 
carefully to make sure they are correct. 

• To change your selections, click Back and make those changes. 

• If the selections are correct, click through the rest of the windows in 
the installation utility to install PATROL for Windows Clustering into 
the KMDS.

Installing the New Version of PATROL for Windows Clustering If You Are Migrating 
Customizations Manually

After you have performed the procedures in “Prepare to Upgrade” on 
page 2-24 and reviewed the information in “Determine Whether You Can 
Migrate” on page 2-32, use this installation procedure if you do not want 
to use the PATROL Migration Tools version 3.5 or the PATROL KMDS to 
migrate the customizations that you have made to the currently installed 
version of PATROL for Windows Clustering.
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Step 1 If you are installing into PATROL 3.4.x in a Unix environment, follow 
these steps to start the installation utility. If you are installing into 
PATROL 3.4.x in a Windows environment or into PATROL 3.5 in a Unix 
or Windows environment, skip to Step 2.

1.A Open a command line prompt.

1.B Change to the drive where the installation CD is located.

1.C At the Unix command line prompt, enter
setup.sh -releaseversion v.r where v.r is the version of the 
PATROL environment into which you are installing.

1.D Skip to Step 3.

Step 2 If you have already installed PATROL 3.5 or PATROL 7.x, or you are 
installing to a Windows environment, start the installation utility by 
running setup.exe (Windows) or setup.sh (Unix) from the installation CD 
or from an electronically downloaded (EPD) installation image. 

Step 3 In the Welcome to the Installation Utility window, click Next to begin 
your installation.

Step 4 In the Review License Agreement window, review the license agreement, 
select Accept, and click Next to continue.

Step 5 In the Select Installation Option window, select one of the following 
options:

• If you want to install the products without creating an installable 
image, select I want to install products on this computer now and click 
Next to continue.
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• If you want to create an installable image that you can use to install 
the products on this computer and other computers later, select I want 
to create an installable image to be installed later, enter the directory 
where you want to store the installable image, and click Next to 
continue.

Note
If you select to create an installable image, all of the computers where 
you plan to use the installable image must share the same BMC Software 
directory, PATROL default logon, PATROL Agent port number, platform, 
and security option. For more information, see “Creating and Installing 
Installable Images” on page 2-45.

Step 6 From the Select Type of Installation Window, select Custom and click 
Next.

Step 7 In the Specify Installation Directory window, enter the appropriate 
directory information based on your installation scenario and click Next.

• If you are installing the PATROL Agent version 3.5 over the top of 
an existing installation, enter the directory path up to the PATROL 
product directory.

For example, if you want to install PATROL into D:\Program 
Files\BMC Software\PATROL3-4, enter D:\Program Files\BMC 
Software in the Specify Installation Directory window.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment on Windows, enter the directory path 
up to the PATROL product directory.

For example, if you want to install PATROL into D:\Program 
Files\BMC Software\PATROL3-4, enter D:\Program Files\BMC 
Software in the Specify Installation Directory window.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment on Unix, enter the full directory path 
to your previously installed products.
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For example, if you previously installed your PATROL products to 
/opt/patrol/PATROL3.4, you should enter /opt/patrol/PATROL3.4 in 
the Specify Installation Directory window.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment and you previously installed your 
existing PATROL products into a top-level directory (such as 
C:\PATROL3-4), enter the full directory path to your previously 
installed products.

For example, if you previously installed your PATROL products to 
D:\PATROL3-4, enter D:\PATROL3-4 in the Specify Installation 
Directory window.

The PATROL installation directory is appended to the path that you enter 
in this step. You will specify the PATROL installation directory in Step 
10 on page 2-39. 

Step 8 From the Select System Roles window, select Managed System, Console 
System, Common Services, or both, using the information provided in 
“Target Computers and Their Roles” on page 2-10, and click Next.

Note
For more information about the PATROL consoles, PATROL Console for 
Unix User Guide, PATROL Console for Microsoft Windows User Guide, 
PATROL Console Server, or RTserver, see PATROL Central Operator – 
Web Edition Getting Started, PATROL Central Operator – Microsoft 
Windows Edition Getting Started, and PATROL Console Server and 
RTserver Getting Started.

Step 9 From the Select Products and Components to Install window, select the 
KMs that you want to install (see Figure 2-3 on page 2-29 and Table 2-2 
on page 2-14) and click Next. 

Note
If your previous installation used a different port number, change the 
default to the current port number for the PATROL Agent. 
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Step 10 In the Provide the PATROL 3.x Product Directory window, enter the 
correct information based on your installation scenario and click Next.

• If you are installing the PATROL Agent version 3.5 over the top of 
an existing installation, enter only the PATROL product directory to 
which you want to install.

For example, if you want to install PATROL into D:\Program 
Files\BMC Software\PATROL3-4, enter PATROL3-4 in the PATROL 
3.x Product Directory window.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment on Windows, enter only the PATROL 
product directory to which you want to install.

For example, if you want to install PATROL into D:\Program 
Files\BMC Software\PATROL3-4, enter PATROL3-4 in the PATROL 
3.x Product Directory window.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment on Unix, do not enter anything. 
Delete any default inputs on this window.

For example, if you previously installed your PATROL products to 
/opt/patrol/PATROL3.4, you must ensure that the PATROL 3.x 
Product Directory window is blank.

• If you are installing PATROL for Windows Clustering into an 
existing PATROL environment and you previously installed your 
existing PATROL products into a top-level directory (such as 
D:\PATROL3-4 or /PATROL3.4), you must ensure that the PATROL 
3.x Product Directory window is blank. Delete any default inputs in 
this window.
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Step 11 Complete the Confirm BMC Startup Information window:

11.A In the Specify the Current Agent Port Number field, enter the 
port number you want the PATROL Agent to use. The default is 
3181. 

Note
If your previous installation used a different port number, change the 
default to the current port number for the PATROL Agent. 

11.B In the Restart the PATROL agent automatically? field, select Yes 
or No:

• If you want the installation utility to restart the PATROL 
Agent after the installation is complete, select Yes. 

• If you want to restart the PATROL Agent after the 
installation is complete, select No.

Note
The Confirm BMC Startup Information window displays only if you are 
installing into a managed system. 

Step 12 Complete the remaining windows. The number and content of the 
windows depend on your KM selections and your inputs to the windows. 
Proceed to “Migrate Your Customizations” on page 2-40.

Migrate Your Customizations

Customizations made to PATROL for Windows Clustering may include 
changes to the parameter alarm ranges, recovery actions, states, or other 
parameter properties. 

You can migrate customizations manually or through the KMDS. 
Migration of .km files through the KMDS is automated, with the 
following exceptions:
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• modified PSL code, whether it is embedded in .km files or in .psl files

• parameter overrides done with a PATROL Operator Console (3.3.00 
and later)

• new Knowledge Modules that you created

Note
Even if you are not using the PATROL KMDS, you can use the PATROL 
migration tools to help you migrate customizations. For more 
information about the PATROL migration tools, see the PATROL 
Migration Tools User Guide. 

Preparing to Migrate

Before you migrate the customizations from the previously installed 
version of PATROL for Windows Clustering to the newly installed 
version of PATROL for Windows Clustering, you remove any obsolete 
KMs from the list of preloaded KMs on each PATROL Agent. See the 
PATROL Agent Reference Manual for instructions on removing KMs 
from the preload list.

To Migrate Using the PATROL Migration Tools Version 3.5

The following procedure is a general workflow for using the PATROL 
Migration Tools version 3.5 to migrate your customizations to the new 
version of PATROL for Windows Clustering. For detailed explanation 
and instruction on using the migration tools, see the PATROL Migration 
Tools User Guide.

Follow this migration procedure only after you have met the following 
criteria:

• completed the procedures in “Prepare to Upgrade” on page 2-24.

• installed version 3.5 of the PATROL migration tools, including the 
KM archive
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Step 1 Run the migration probe to locate the base version of PATROL for 
Windows Clustering from the KM archive and the new version of 
PATROL for Windows Clustering from the product CD.

Step 2 Run the merge tool to merge the base and customized versions of 
PATROL for Windows Clustering with the new version of PATROL for 
Windows Clustering.

Step 3 Choose one of the following methods to transfer merged KMs to your 
test environment:

• Copy the contents of the results directory to the /lib directory where 
the new version of PATROL for Windows Clustering is installed.

• Copy the contents of the packaged results to a CD image and then 
use that CD to install. 

• Deploy the contents of the merged results directory using a 
third-party deployment system.

Step 4 Perform any additional optional migration tasks as described in the 
PATROL Migration Tools User Guide.

To Migrate Using the PATROL Migration Tools Version 3.4.11 and the KMDS

Note
Before beginning this procedure, ensure that you use the PATROL 
KMDS version 3.4.11 and apply any available patches. 

After you have checked your customizations to the previous version of 
PATROL for Windows Clustering into the KMDS, use the following 
steps to migrate your customizations to the new version of PATROL for 
Windows Clustering. For detailed instructions about migrating 
customizations using the KMDS, see the PATROL Migration Tools User 
Guide.
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Step 1 Use the Probe and Merge tools to identify, preserve, and merge 
customizations from the prior version of PATROL for Windows 
Clustering into the newly installed version of PATROL for Windows 
Clustering. See the PATROL Migration Tools User Guide to run the 
Probe and Merge tools. 

Step 2 When prompted during the merge phase of the migration, enter the 
following map file name:

• mcs_km_1_5_00.map
• lbs_km_1_5_00.map

Warning
Make sure that you use the merge map file that was shipped with the new 
version of PATROL for Windows Clustering. The default location is 
PATROL_HOME\lib\migration\new\lib\kmmergemap.

Step 3 Use KMDS to merge.

Step 4 After you have completed the migration of your changes, load the new 
version and save the configuration. 

To Migrate Customizations Manually

If you do not want to use the KMDS to migrate customizations, use the 
following steps to migrate your customizations manually:

Step 1 Move the old PATROL for Windows Clustering to a new directory that is 
different from PATROL_HOME.

Step 2 Identify the customizations in PATROL for Windows Clustering by 
comparing the content of the text file of the KM in the current PATROL 
for Windows Clustering version with the content of the text file for the 
customized KM that is saved in the PATROL Console cache backup 
directory.

Step 3 Incorporate your customizations to the new PATROL for Windows 
Clustering by performing the following steps:
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3.A Restart the PATROL Console.

3.B Load the newly installed PATROL for Windows Clustering.

3.C Using a PATROL Developer Console, enter the customizations 
that you identified in Step 2, one by one.

To Migrate Customized PATROL Script Language Code

Customizations made to PATROL Script Language (PSL) code are not 
automatically migrated. These customizations may be embedded in .km 
files or stored in separate .psl files. Migrate these customizations 
manually, using the following guidelines:

• If you modified .psl files that were shipped by BMC Software, you 
must manually re-edit the PSL code in the new KM by using a 
PATROL Developer Console to reapply your changes.

• If you modified PSL code embedded in a KM, that code will be 
overwritten when you install a new version of the product. You must 
manually edit the .km files by using a PATROL Developer Console to 
reapply your changes.

• If you created a new PSL file (not shipped by BMC Software) 
outside of a .km file, or if you created new PSL code (not shipped by 
BMC Software) and embedded it in a KM that was shipped by BMC 
Software, use the pslsearch utility to search your KM for terms that 
you may have used that have since been adopted by BMC Software 
as PSL keywords. Reapply your changes by using a PATROL 
Developer Console. For instructions about using the pslsearch utility, 
see the PATROL Migration Tools User Guide.

Note
If you have customized a PSL library that was compiled with an earlier 
version of the PSL compiler than the version that was provided with 
PATROL 3.2.09i, you must manually recompile the library by using the 
PATROL 3.4.11 or later compiler.
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Creating and Installing Installable Images

The PATROL installation utility installs only to a local computer. The 
installation utility cannot perform remote installations. You must install a 
PATROL Agent and PATROL for Windows Clustering locally on each 
computer that you want to monitor. You also must install a PATROL 
Console and PATROL for Windows Clustering locally on each computer 
from which you want to view results. 

The installation utility does provide you with the ability to create an 
installable image from the products that you select during a regular local 
installation. If you place the installable image in a shared directory, you 
can use that installable image to install the selected BMC Software 
products on all computers that perform the same roles and have these 
identical requirements:

• same shared BMC Software directory
• same PATROL default logon
• same PATROL Agent port number
• same platform 
• same security option 

You can also use a distribution server to distribute the installable images 
that you create.

Create an Installable Image

If you selected the I want to create an installable image to be installed later. 
option in the Select Installation Option window during the installation 
process, then you elected to create an installation image that you can 
execute later on the current computer or on several computers that share 
the same roles and installation selections.

Once you select Create Image in the Review Selections and Create 
Installable Image window, the installation utility finishes exporting the 
installation image.
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The installation utility creates an install.ctl file in the specified directory 
that includes all the configuration information needed to install the 
products that you selected in the Product Selection window.

Before you run the installation image, you might want to change the 
properties for the image. Read the following instructions and decide 
whether changing the image is appropriate for your environment:

• If you want to run the installation package more than once from the 
same location, change the properties on the installation image file, 
install.ctl, to Read-Only. 

Warning
The install.ctl file includes the encrypted password for the account that 
was used during the install process. If the install.ctl file is set to 
Read-Only, ensure that the install.ctl file is removed from all computers 
to which the installation image is copied.

• If you want to distribute the installation image from a central location 
to multiple machines, do not change the properties of the install.ctl 
file to Read-Only.

Warning
If you do not change the install.ctl file to Read-Only, it is deleted after the 
first time you execute the installation image, and you will not be able to 
use the exported installation image more than once. 

Install the Created Installable Image

After you create the installable image, as described on page 2-45, you 
can then use it to install PATROL for Windows Clustering on a local 
computer of the same platform that performs the same roles and has the 
same shared BMC Software directory, PATROL default logon, PATROL 
Agent port number, and security options as the options in the installable 
image. Use the following steps:
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Step 1 Navigate to the directory where the installable image resides. 

Step 2 Run the installation utility:

• On Windows, double-click the install.exe file or type install.exe at a 
command prompt.

• On Unix, type ./install.sh at a command prompt.

The installation utility executes and then creates an installation log that 
lists the products installed, which you can view. The text at the end of the 
installation log indicates whether or not the installation was successful.

Installing the Online Help
The online Help for PATROL for Windows Clustering is automatically 
installed into the PATROL Console for Microsoft Windows when you 
install the KM. However, the online Help does not automatically install 
into the PATROL Central–Microsoft Windows Edition console; you must 
install it separately. 

If you plan to install the Unix version of PATROL for Windows 
Clustering on a PATROL for Unix console, you must install the Unix 
version of the Help browser separately if it is not already installed. 

Install Help into PATROL Central - Microsoft Windows Edition

Use the following instructions to install the PATROL for Windows 
Clustering Help into the PATROL Central–Microsoft Windows Edition 
console from the PATROL Foundations Kit CD:

Step 1 Insert the PATROL Foundations Kit CD into your CD-ROM drive.

Step 2 From the CD, run setup.exe (Windows) or setup.sh (Unix).

Step 3 Follow the installation instructions until you reach the Select Type of 
Installation window. 
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Step 4 Select Custom and click Next. 

Step 5 In the Select Installation Directory window, enter the directory where 
PATROL for Windows Clustering is installed and click Next. 

Step 6 In the Select System Roles window, select Common Services and click 
Next. 

Step 7 In the Select Products and Components to Install window, expand the 
PATROL Console Server (PATROL 7. x) folder. 

Step 8 Expand the KM Help Files for PATROL Central – Microsoft Windows 
Edition folder. 

Step 9 Select PATROL for Microsoft Windows Clustering Help and click Next. 

Step 10 Finish the installation, selecting the same options that you used when 
installing PATROL for Windows Clustering.

Install the Unix Version of the Help Browser 

The browser required for the Unix version of PATROL Help is Netscape 
Navigator version 3.01 through 4.78. However, if you are running a Red 
Hat Linux platform, you must run Netscape Navigator version 4.x to 
display the online Help. Currently, PATROL Help does not support 
Netscape Navigator 6.0.

You must install Netscape Navigator on the computer where the PATROL 
Console resides. You can install Netscape anywhere on your Unix 
computer as long as the binary is in the path. 

Netscape Navigator is supplied by Netscape Communications Corp. You 
can locate the browser at http://home.netscape.com/download. 
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Additional Considerations for Using Online Help for Unix

When you select Help from the PATROL Console on a Unix system, it 
may take a few seconds for the Help browser to launch. Two windows 
will be displayed. First the Netscape Navigator window is displayed as 
an icon, and then a browser window that contains the Help is displayed.

In addition, you must be aware of the following restrictions:

• Netscape Navigator displays warning messages when it is invoked 
multiple times within the same user account because of its 
file-locking mechanism. It will, however, continue functioning.

• By default, when Netscape Navigator starts, it uses a private color 
map. As a result, you might experience color flashing on your 
workstation. If so, you can set the value of PATROL_BROWSER so 
that the colormap option is not specified. However, some subsequent 
color requests might fail and the online Help will be improperly 
displayed.

• The eXceed for Windows NT X Window Server product by 
Hummingbird Communication Ltd. may not always display the Help 
files properly.

Consult your Netscape Navigator documentation for specific platform 
requirements and restrictions. 

Setting Environment Variables for the Browser

The LANG, PATH, and PATROL_BROWSER environment variables 
must be set for the Help browser to run properly. The following sections 
describe these variables.

LANG Variable

On some platforms, the Unix LANG environment variable must be set to 
C so that Netscape Navigator will work properly. Otherwise, you might 
experience product failures. 

Set your user or system .profile for Bourne or Korn shells as follows:
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LANG=C

export LANG

For C shell users, issue the following command:

setenv LANG C

PATH Variable

The PATROL user account PATH variable must contain the location of 
the directory containing the Netscape files. If the directory containing the 
Netscape files is not on the path, add the directory to the PATROL user 
account path.

This requirement applies only to the PATROL user account on the same 
computer as the PATROL Console.

PATROL_BROWSER Variable

When PATROL starts the Help browser, it uses the command in the 
PATROL_BROWSER environment variable. As a default, the 
PATROL_BROWSER environment variable contains the following 
command:

netscape -display $DISPLAY -install -iconic

To use different arguments, set the value of PATROL_BROWSER to the 
appropriate string. For example:

export PATROL_BROWSER=/usr/local/bin/netscape -raise
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Using PATROL KM for Cluster Server at PATROL 
Security Level 3 or 4

Please read the following explanation and perform the procedure to use 
the PATROL KM for Cluster Server at PATROL Security Level 3 or 4.

Issue With Using PATROL for Microsoft Cluster Server at PATROL Security Level 3 or 4

Note
Security level settings at each of the cluster nodes must be identical to the 
security level at the cluster-level agent machine.

With PATROL security level 3 or 4, communication between the 
PATROL Agent and the PATROL KM for Cluster Server is disrupted 
because of the following:

• The McsGateway process, spawned by the PATROL MCS Monitor 
service, can operate only within the context of a domain account, 
rather than within a local system account.

• At security levels 3 and 4, the PATROL security components do not 
interact with a service running under the context of a domain 
account, without prompting you with an access dialog box.

A workaround for this issue exists only if the KM is operating in 
unattended mode. (No workaround is available for attended mode in 
which access dialog boxes are displayed.)

Providing Support for Security Levels 3 or 4 in Unattended Mode

To enable the KM functionality—in unattended mode only—at security 
level 3 or 4, perform these three steps on the cluster-level agent machine:
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Step 1 Run the PATROL Security Utility plc_password with appropriate 
command-line parameters:

• Path to utility:

C:\Program Files\BMC 
Software\common\security\bin\Windows-x86\plc_password.exe

• Full example command-line entry, with parameters:

plc_password -r client -P PATROL\SecurityPolicy\esi 
-m unattended -f “C:\Program Files\BMC 
Software\common\security\keys\tree.bin” -k <key 
database file>

Note
The -k command-line parameter specifies the path and file name of the 
user-defined SSL Key Database file (.kdb). See the PATROL Security 
User Guide for details about the SSL Key Database file and PATROL 
Security Utilities.

Step 2 If you are installing and configuring PATROL KM for Cluster Server on 
a cluster-level agent machine, add clusters to the monitoring list:

• To select a cluster for monitoring, access the MCS_Clusters 
application class menu, then choose PATROL Admin => Select 
Cluster to Monitor. (See also PATROL KM for Microsoft Cluster 
Server Help, “Maintaining the monitored cluster list.”)

• If you are prompted for authorized account information, provide the 
domain name, user name, and password for the cluster administrator 
account.

Step 3 Stop and start the PATROL MCS Monitor service: 
To start or stop the PATROL MCS Monitor service on a cluster-level 
agent machine, access the MCS_Clusters application class menu, then 
choose PATROL Admin => MCS Monitor Stop/Start. (See also PATROL 
KM for Microsoft Cluster Server Help, “Starting or stopping the 
PATROL MCS Monitor (McsService).”)
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Uninstalling
For instructions about uninstalling PATROL products see the PATROL 
Installation Guide.

Where to Go from Here

The following table suggests topics that you should read next:

If you want information about See

overview of PATROL for Windows Clustering 
components and capabilities

Chapter 1, “Product Components and Capabilities”

how to load and configure the PATROL KM for 
Cluster Server or PATROL KM for Network 
Load Balancing using the PATROL Console

Chapter 3, “Loading and Configuring PATROL for 
Windows Clustering KMs”

how to use the PCC Wizard to help you 
configure the PATROL Agent for failover in a 
Microsoft Cluster Server environment

Chapter 4, “Using the PATROL Cluster 
Configuration Wizard”

how to use the PATROL for Windows 
Clustering KMs, and detailed descriptions of 
the applications, menu commands, and 
InfoBoxes

• PATROL KM for Cluster Server online Help or
• PATROL KM for Network Load Balancing online 

Help

parameter descriptions and defaults • PATROL KM for Cluster Server online Help or
• PATROL KM for Network Load Balancing online 

Help or
• PATROL Parameter Reference Manual

accessing menu commands, InfoBoxes, and 
online Help

Appendix A, “Accessing Menu Commands, 
InfoBoxes, and Online Help” 

PATROL Agent configuration variables Appendix B, “Agent Configuration Variables” 
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3

Loading and Configuring PATROL for 
Windows Clustering KMs 3

This chapter provides you with information that you will need to load 
and configure the PATROL for Windows Clustering KMs. The following 
topics are discussed:

Preparing to Use PATROL for Windows Clustering  . . . . . . . . . . . . . 3-2
Configuration Tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3

Loading the PATROL for Windows Clustering KMs  . . . . . . . . . 3-3
Configuring the PATROL KM for Cluster Server . . . . . . . . . . . . 3-13
Configuring the PATROL KM for Network Load Balancing  . . . 3-16
Configuring Recovery Actions  . . . . . . . . . . . . . . . . . . . . . . . . . . 3-19

Displaying PATROL Data Using the PATROL Adapter for Microsoft 
Office. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-21

Using the PATROL Adapter for Microsoft Office to Display 
PATROL Data in Microsoft Excel  . . . . . . . . . . . . . . . . . . . . . . 3-21

Built-In Report Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-22
Where to Go from Here . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-24
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Preparing to Use PATROL for Windows 
Clustering

If PATROL for Microsoft Windows Clustering has not been installed, see 
Chapter 2, “Installing and Migrating PATROL for Windows Clustering.” 
After installing, return to this section for information on how to configure 
the components. 

Before configuring the PATROL for Microsoft Windows Clustering 
components, you should verify that the following software requirements 
are met:

• The PATROL Console version 3.4.11 or later and PATROL for 
Microsoft Windows Clustering must be installed on the computer 
you want to use for the PATROL Console.

• The PATROL Agent version 3.4.11 or later and PATROL for 
Microsoft Windows Clustering must be installed on the computers 
you want to monitor and manage.

• The PATROL KM for Windows OS must be installed on the cluster 
nodes.

• The necessary product component files must be installed on the 
PATROL Console computers and the PATROL Agent computers. 

You should also verify that you have access to all required information 
about the domain controllers or Windows servers that you want to 
monitor and manage.
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Configuration Tasks
This section describes how to load and configure the PATROL for 
Windows Clustering components: PATROL KM for Cluster Server and 
PATROL KM for Network Load Balancing.

Loading the PATROL for Windows Clustering KMs

If you did not install KM components to PATROL Classic Console for 
Windows, then you must load the KMs to your PATROL Console before 
configuring the KMs. KMs are automatically loaded into the PATROL 
Classic Console for Windows after installation. If you installed KMs to 
PATROL Classic Console for Windows, then skip to “Configuring the 
PATROL KM for Cluster Server” on page 3-13 or “Configuring the 
PATROL KM for Network Load Balancing” on page 3-16.

If you delete KMs, you can refer to this section if you want to reload 
them. This section provides instructions for loading KMs with the 
following PATROL Consoles:

• PATROL Central Operator–Windows Edition
• PATROL Central Operator–Web Edition
• PATROL Console for Windows
• PATROL Console for Unix

Note
After you install components from the Select Products and Components 
to Install dialog box during the installation process, you must load the 
corresponding .kml files before the PATROL Agent and PATROL 
Console can use them.

Before You Begin Loading a KM

Make sure you have met the following requirements:

• the components that you want to load on the agent and console 
computers are installed
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• the agents to which you want to load components are running
• the PATROL Console is running and connected to the agent(s) you 

want to manage
BMC Software, Inc., Confidential and Proprietary Information

3-4 PATROL for Microsoft Windows Clustering Getting Started



Loading Knowledge Modules

Summary: Before you can begin using Knowledge Modules (KMs) that have not 
been preloaded, you must first load them with a PATROL Console. 
Follow the instructions that apply to your console.

Loading KMs with PATROL Central Operator–Windows Edition

PATROL Central Operator–Windows Edition has a Loading KMs wizard 
with which you can select KMs and the computers on which they are 
loaded. 

Step 1 In the Common Tasks tab of the taskpad, click the Load Knowledge 
Modules icon. 

PATROL displays the wizard.

Step 2 Click Next to start the wizard. 

The wizard displays a list of computers on which a PATROL Agent has 
been installed.

Step 3 Select the check boxes for the computers on which you want to load 
KMs, and then click Next.

The wizard displays a list of available .kml files for each computer 
selected in the previous step. MCS_Load.kml loads the PATROL KM for 
Cluster Server and LBS.kml loads the PATROL KM for Network Load 
Balancing. Each .kml file is listed once for each computer. You can 
display .km files by changing the filter.
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Step 4 Select the check boxes for the KM and computer pair that you want to 
load.

Note
Unless you are an advanced PATROL user, use the .kml files to load 
product component files. Loading individual .km files can break the 
interdependencies between the .km files, while loading .kml files 
preserves these dependencies.

Step 5 Click Next, and then click Finish.

PATROL loads the selected KMs on the selected computers.
BMC Software, Inc., Confidential and Proprietary Information

3-6 PATROL for Microsoft Windows Clustering Getting Started



Loading KMs with PATROL Central Operator–Web Edition

PATROL Central Operator–Web Edition has a Loading KMs feature with 
which you can select KMs and the computers on which they are loaded. 

Step 1 From the Managed Systems page, click the Load/Unload KMs button.

The Load KMs page opens, listing each computer on which a PATROL 
Agent has been installed.

Step 2 Select the computer (or computers) on which you wish to load KMs, and 
then click Next.

The Load KMs page displays a list of available .km and .kml files.
MCS_Load.kml loads the PATROL KM for Cluster Server and
LBS.kml loads the PATROL KM for Network Load Balancing.

If you selected more than one computer in this step, the only .km and 
.kml files that are shown are the ones that have been installed on all of the 
selected computers. If a particular .km or .kml file was installed on only 
one computer, then you must choose that computer by itself to load the 
file.

Step 3 Select the .km or .kml files that you want to load.

Note
Unless you are an advanced PATROL user, use the .kml files to load 
product component files. Loading individual .km files can break the 
interdependencies between the .km files, while loading .kml files 
preserves these dependencies.

Step 4 Click Finish.

PATROL loads the selected KMs on the selected computers.

Note
If you want to load a .km or .kml file that was not listed in step 2, ensure 
that the KM is installed on the appropriate computer and select only that 
computer in step 2.
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Loading KMs with the PATROL Console for Windows

Step 1 From the PATROL Console menu bar, choose File => Load KM.

The Load KMs dialog box displays a list of available .kml files.
MCS_Load.kml loads the PATROL KM for Cluster Server and
LBS.kml loads the PATROL KM for Network Load Balancing.

Step 2 Select one or more of the .kml files, and click Open.

PATROL loads the selected KMs on all of the computers listed in the 
PATROLMainMap.

Loading KMs with the PATROL Console for Unix

Step 1 From the PATROL Console menu bar, choose File => Load KM.

The Load KMs dialog box displays a list of available .kml files.
MCS_Load.kml loads the PATROL KM for Cluster Server and
LBS.kml loads the PATROL KM for Network Load Balancing.

Step 2 Select one or more of the .kml files and click Open.

PATROL loads the selected KMs on all of the computers to which your 
console is connected.
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Unloading Knowledge Modules 

Summary: If you no longer want to use an application class that you previously 
loaded, you can unload the .km file so that its application class will no 
longer appear in your console. In some consoles, unloading is referred to 
as deleting. When you unload or delete a .km file using a console, the file 
is not deleted from the patrol\knowledge directories on the PATROL 
Console or the PATROL Agent computers. 

Unloading a KM in the PATROL Central Operator–Windows Edition

PATROL Central Operator–Windows Edition has a wizard with which 
you can unload specified .km files from specified computers. 

Step 1 In the Common Tasks tab of the taskpad, click the Unload Knowledge 
Modules icon. 

PATROL displays the wizard.

Step 2 Click Next to start the wizard. 

The wizard lists each computer on which a PATROL Agent has been 
installed.

Step 3 Select the check boxes for the computers from which you want to unload 
.km files, and then click Next.

The wizard displays a list of application class names (that correspond to 
.km file names) for each computer selected in the previous step. Each 
application class name is listed once for each computer.

Step 4 Select the check boxes for the .km and computer pair that you want to 
unload, and then click Next. 

Step 5 Click Finish. 

The console removes the selected .km files from the current management 
profile.
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Unloading a KM in the PATROL Central Operator–Web Edition

PATROL Central Operator–Web Edition has a feature with which you 
can unload specified .km files from specified computers. 

Step 1 From the Managed Systems page, click the Load/Unload KMs button.

The Load KMs page opens, listing each computer on which a PATROL 
Agent has been installed.

Step 2 Select the computers from which you want to unload .km files, and then 
click Next.

The Load KMs page displays a list of .km files. Currently loaded .km 
files are highlighted in the list.

Step 3 Deselect the .km files that you want to unload. 

Step 4 Click Finish.

PATROL removes the .km files that you deselected in step 3.
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Unloading a KM in the PATROL Console for Microsoft Windows Servers

Unloading a KM is also referred to as deleting a KM in the PATROL 
Console for Microsoft Windows Servers. 

Step 1 From the KM tab of the tree view, right-click the application class name 
that you want to delete and choose Delete from the pop-up menu.

The console displays a dialog box that asks if you want to delete the 
selected application.

Step 2 Click Yes to delete the application class.

The application class is removed from your cache directory and your 
console session file.

Step 3 Repeat Step 1 and Step 2 until you have deleted all of the application 
classes associated with the KM that you want to delete.

Step 4 From the console menu bar, choose File => Save KM to save your 
changes.
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Unloading a KM in the PATROL Console for Unix 

Unloading a KM is also referred to as deleting a KM in the PATROL 
Console for Unix. 

Step 1 From the PATROL Main window, choose Attributes => Application 
Classes.

The console displays the List of Application Classes window.

Step 2 Click the name of the application class that you want to delete.

The console highlights the application class name.

Step 3 From the List of Application Classes menu bar, choose Edit => Delete.

The application class is removed from your cache directory and your 
console session file. The PATROL Console removes the application class 
name from the List of Application Classes.

Step 4 Repeat Step 2 and Step 3 until you have deleted all of the application 
classes associated with the KM that you want to delete.

Step 5 From the List of Application Classes menu bar, choose File => Save KM 
to save your changes.
BMC Software, Inc., Confidential and Proprietary Information

3-12 PATROL for Microsoft Windows Clustering Getting Started



Configuring the PATROL KM for Cluster Server

This task assumes that you are connected to a cluster-level agent machine 
with your PATROL Console.

Step 1 Add the host, which corresponds to your cluster-level agent by choosing 
Host => Add.

The Add Host dialog box is displayed.

Step 2 Complete the Add Host dialog box information and click OK.

The Select Cluster to Monitor dialog box (Figure 3-1) is displayed.

Figure 3-1   Select Cluster to Monitor Dialog Box

Step 3 From the Select Cluster to Monitor dialog box, select or add the clusters 
you want to monitor and click Apply.

Note
You can monitor a cluster with only one cluster-level agent at one time.

Step 4 Click Close to close the dialog box and to display the Authorized 
Account dialog box (Figure 3-2 on page 3-14).
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Figure 3-2   Authorized Account Dialog Box

Step 5 Enter an account that has access type Full Control for the clusters you 
want to monitor. This account allows the cluster-level agent and external 
executables to access the cluster nodes you want to monitor. 

• In the Domain name field, enter the domain of the authorized account 
you want to use.

• In the User name field, enter the user name of the authorized account 
you want to use.

• In the Password field, enter the password of the authorized account 
you want to use.

• In the Verify Password field, reenter the password of the authorized 
account you want to use.

Step 6 Click OK, and then Close.

You have completed the PATROL KM for Cluster Server configuration. 
Your Desktop tree view should look similar to Figure 3-3 on page 3-15.
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Figure 3-3   Desktop Tree View of PATROL KM for Cluster Server
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Configuring the PATROL KM for Network Load Balancing

This task assumes that you

• are connected to a PATROL Agent machine with your PATROL 
Console.

• have loaded the PATROL KM for Network Load Balancing.

Step 1 From the LBS_Clusters application icon, choose KM Commands => 
Manually Add Cluster.

The Manually Add Cluster dialog box (Figure 3-4) is displayed.

Figure 3-4   Manually Add Cluster Dialog Box

Step 2 In the Enter a Cluster Name or an IP Address field, enter the cluster name 
or IP address of the cluster you want to add.

Step 3 Click Apply.

Step 4 Repeat steps 2 and 3 for each cluster you want to add.

Step 5 Click Close.

Step 6 From the LBS_Cluster application class (the cluster you just added), 
choose KM Commands => Manually Add a Node.
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The Manually Add a Node dialog box (Figure 3-5) is displayed.

Figure 3-5   Manually Add a Node Dialog Box

Step 7 In the Enter a Node Name or an IP Address field, enter the node name or 
IP address of the cluster node you want to add.

Step 8 Click Apply.

Step 9 Repeat steps 7 and 8 until all cluster nodes have been added.

Warning
You must add all nodes within a Network Load Balancing cluster. If you 
monitor only some of the Network Load Balancing cluster nodes, the 
cluster may enter a converging state when PATROL runs the Converge 
NLB Nodes recovery action or when you execute the following menu 
commands: Configure Port Rules or Cluster Control. (Convergence is the 
process of verifying port rules consistency and joining nodes to the 
cluster.)

Step 10 Click Close to finish the configuration.

You have completed the PATROL KM for Network Load Balancing 
configuration. Your Desktop tree view should look similar to Figure 3-6 
on page 3-18.
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Figure 3-6   Desktop Tree View of PATROL KM for Network Load Balancing
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Configuring Recovery Actions

PATROL for Microsoft Windows Clustering provides built-in recovery 
actions (corrective actions taken by PATROL when a parameter reaches a 
set value or is in a warning or alarm state) for many KMs. Use these 
procedures to configure specific recovery actions.

Step 1 Right-click the host application menu and choose KM Command => 
Configure Recovery Actions from the pop-up menu.

Step 2 From the list of recovery actions, highlight the desired recovery action 
and click Accept.

Step 3 From the list of recovery action instances, highlight the instance and 
click Edit. For information about which instance to select, see Table 3-1. 

Table 3-1 Selecting a Recovery Action Instance

Purpose Recovery Action to Select

configure the recovery action for a 
specific instance (for example, a 
monitored process)

the recovery action instance that 
displays the name of the application 
instance in the INSTANCE column

configure the recovery action for all 
instances (for example, all 
monitored processes)

the recovery action that displays an 
asterisk (*) in the INSTANCE column
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Step 4 From the Configure Recovery Action dialog box, choose from the 
settings described in Table 3-2.

Note
For more information on the recovery action and its configuration 
options, click the Help button.

Step 5 To save your changes, click Accept.

Table 3-2 Recovery Action Configuration Options

Setting Description

Mode: 
Run 
automatically

If you select this mode, PATROL runs the recovery action 
automatically, without prompting you.

Mode: 
Run only with 
operator 
confirmation

If you select this mode, PATROL prompts you before 
running the recovery action.

Note: If you select this option, be sure to keep a console 
connected to the PATROL Agent on the managed 
machine. If you have no console connection, PATROL is 
unable to prompt you. The recovery action will time out 
and not run.

Mode:
Do not execute

If you select this mode, PATROL does not perform the 
recovery action.

Suspend 
Recovery Action

If you select this option, PATROL temporarily pauses the 
recovery action. When you resume the recovery action (by 
deselecting this check box) the previous recovery action 
settings take effect.

Attended Mode 
Dialog Timeout

If the recovery action is configured in Run only with 
operator confirmation mode, this setting specifies the 
amount of time PATROL waits for confirmation to run the 
recovery action. If you do not provide confirmation within 
the allotted time, PATROL does not run the recovery 
action.
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Displaying PATROL Data Using the PATROL 
Adapter for Microsoft Office

If you install the PATROL Adapter for Microsoft Office during the 
console pass of the PATROL for Microsoft Windows Clustering 
installation, you can display PATROL data in Microsoft Excel through 
the PATROL Adapter for Microsoft Office wizard. For information on 
how to view PATROL data through the PATROL Adapter for Microsoft 
Office wizard, see “Using the PATROL Adapter for Microsoft Office to 
Display PATROL Data in Microsoft Excel” on page 3-21.

Using the PATROL Adapter for Microsoft Office to Display 
PATROL Data in Microsoft Excel

To start the PATROL Adapter for Microsoft Office from Microsoft Excel, 
follow these steps:

Step 1 Start Microsoft Excel.

Step 2 Choose File => New.

The New dialog box appears.

Step 3 Choose the Spreadsheet Solutions tab.

Step 4 Choose the Patrol Report.xlt template.

Step 5 Click OK.

The New dialog box is dismissed and the Microsoft Excel macros 
message appears.

Step 6 Click Enable Macros. 

To run the wizard, the Microsoft Excel security level must be either Low 
or Medium. If the security level is High, the wizard does not run and 
displays no error messages. To change the Microsoft Excel security level, 
start Excel and choose Tools => Macro => Security.
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Step 7 See the PATROL Adapter for Microsoft Office User Guide for 
instructions on generating a report.

How to Use the PATROL Adapter for Microsoft Office

For more information on how to use the PATROL Adapter for Microsoft 
Office, see the PATROL Adapter for Microsoft Office User Guide.

Built-In Report Templates

Several products have predefined reports that you can use immediately. 
For a list of these predefined reports, see the following sections.

Report Options for PATROL for Microsoft Windows Clustering

The predefined report templates in Table 3-3 are available when you use 
the PATROL Adapter for Microsoft Office:

Table 3-3 Reports for PATROL KM for Microsoft Cluster Server

Report name Description

Cluster Avg. Workload - Weekly the average workload handled by the cluster during 
a seven-day period

Cluster Object Status - Weekly the status of the cluster during a seven-day period

FShare-IP Availability - Weekly the availability of the file share and IP during a 
seven-day period

IP Response Time - Weekly the IP response time during a seven-day period

Table 3-4 Reports for PATROL KM for Network Load Balancing

Report name Description

Daily Alarm & Warning Summary a summary of all alarms and warnings for the past 
24 hours

Daily Available Bytes a summary of available bytes for each monitored 
node for the past 24 hours

Daily CPU Usage Pct. a summary of CPU usage for each monitored node 
for the past 24 hours
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Daily Events a summary of events for all monitored nodes for the 
past 24 hours

Daily Page File Usage Pct. a summary of page file usage for each monitored 
node for the past 24 hours

Daily Web Service Connections a summary of the number of Web connections for 
each monitored node for the past 24 hours

Weekly Alarm & Warning Summary a summary of all alarms and warnings for the past 
7 days

Weekly Available Bytes a summary of available bytes for each monitored 
node for the past 7 days

Weekly CPU Usage Pct. a summary of CPU usage for each monitored node 
for the past 7 days

Weekly Events a summary of events for all monitored nodes for the 
past 7 days

Weekly Page File Usage Pct. a summary of page file usage for each monitored 
node for the past 7 days

Weekly Web Service Connections a summary of the number of Web connections for 
each monitored node for the past 7 days

Table 3-4 Reports for PATROL KM for Network Load Balancing

Report name Description
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Where to Go from Here
The following table suggests topics that you should read next:

If you want information about See

overview of PATROL for Windows Clustering 
components and capabilities

Chapter 1, “Product Components and Capabilities”

how to install PATROL for Windows Clustering Chapter 2, “Installing and Migrating PATROL for 
Windows Clustering”

how to use the PCC Wizard to help you 
configure the PATROL Agent for failover in a 
Microsoft Cluster Server environment

Chapter 4, “Using the PATROL Cluster 
Configuration Wizard”

how to use the PATROL for Windows 
Clustering KMs, and detailed descriptions of 
the applications, menu commands, and 
InfoBoxes

• PATROL KM for Cluster Server online Help or
• PATROL KM for Network Load Balancing online 

Help

parameter descriptions and defaults • PATROL KM for Cluster Server online Help or
• PATROL KM for Network Load Balancing online 

Help or
• PATROL Parameter Reference Manual

accessing menu commands, InfoBoxes, and 
online Help

Appendix A, “Accessing Menu Commands, 
InfoBoxes, and Online Help” 

PATROL Agent configuration variables Appendix B, “Agent Configuration Variables” 
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4

Using the PATROL Cluster 
Configuration Wizard 4

This chapter provides you with information that you will need to use the 
PATROL Cluster Configuration Wizard (also referred to as PCC). The 
following topics are discussed:

Using the PATROL Cluster Configuration Wizard. . . . . . . . . . . . . . . 4-2
Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2
Before You Begin. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-3
Access Requirements for Running the PCC Wizard . . . . . . . . . . 4-4
Starting the PCC Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-4
How to Use the PCC Wizard . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-4

Post-PCC Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-10
Manually Configuring the PATROL Agent for Clustering. . . . . . . . . 4-11

Install the Application on each Cluster Node  . . . . . . . . . . . . . . . 4-11
Install the PATROL Agent on each Cluster Node . . . . . . . . . . . . 4-11
Assign a Unique Port Number . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-12
Distribute License File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-12
Define the PATROL Cluster-Specific Environment Variables. . . 4-12
Create and Register a New Service for the PATROL Agent  . . . . 4-13
Define the PATROL Agent as a Member of the Group . . . . . . . . 4-13

PATROL Cluster-Specific Environment Variables for History and 
Configuration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-20

Variables. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-20
Operation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-21
Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-22

Where to Go from Here . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-23
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Using the PATROL Cluster Configuration Wizard

Install the PATROL Cluster Configuration (PCC) Wizard to help you 
configure the PATROL Agent for failover in a Microsoft Cluster Server 
environment. For installation instructions, see “PATROL Cluster 
Configuration Wizard” on page 2-15.

Overview

The PCC Wizard allows you to easily configure the PATROL Agent to 
monitor cluster-aware applications such as Microsoft Exchange Server. It 
does this by

• configuring the agent to operate on a virtual server name and 
separate port

• storing the agent history and configuration data on cluster-shared 
media

Thus, in the event of a node failure, the agent will failover to another 
node with the monitored application, while providing a consistent view 
of the data being collected. For example, the history data is kept intact.

The Wizard does not enable the monitoring of clustered resources. That 
functionality is handled by the PATROL Agent and the PATROL KM for 
Cluster Server. The Wizard automates and simplifies cluster 
configuration of the PATROL Agent, and eliminates configuring the 
agent manually.
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Before You Begin

Before you begin using the PCC Wizard, you must 

• install PCC on any computer in the cluster domain
• install PATROL Agent on all nodes in the cluster
• know the user name and password of a cluster administrator account
• install the Microsoft Cluster Administrator
• identify a group to install the PATROL virtual Agent into; this group 

will need to contain the following (at a minimum):

— Physical Disk
The PATROL virtual Agent stores history and configuration data 
on a standard cluster-shared disk which, if possible, should not 
be the quorum disk.

— IP Address
In conjunction with the Network Name resource, the PATROL 
virtual Agent uses the IP address to allow access by the PATROL 
Console.

— Network Name
A network name is required for each PATROL virtual Agent 
configured. The PATROL virtual Agent uses the network name 
to form a virtual server for the PATROL Console to access. Thus, 
the PATROL virtual Agent can fail over to any node capable of 
running the resource.

Note
The node that you run the PCC Wizard from should be the current owner 
of the group you select. This recommendation prevents some caution 
pop-up windows from appearing.

For information about how the PATROL Agent supports an application in 
a cluster environment and what type of failover tolerance it provides, see 
the PATROL Agent Reference Manual.
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Access Requirements for Running the PCC Wizard

The account you use to run the PCC Wizard must be a member of the 
local administrator group.

Starting the PCC Wizard

You can start the wizard by

• choosing Start => Programs => BMC PATROL => PATROL Cluster 
Configuration Wizard.

• typing pcc from the Run command.

How to Use the PCC Wizard

Once you have installed PCC Wizard on all nodes, use the following 
instructions to use the PCC Wizard to configure the PATROL Agent 
resources. You will only need to run the PCC Wizard once, from a single 
node. All nodes will be configured at that time.

Information Required by PCC

Use the table below to plan your configuration of each PATROL Agent 
resource.

Table 4-1 Information Required by PCC

Required 
Information Your Information PCC

Cluster Name adds the PATROL Agent resource to the cluster 
you select or enter.

Group Name(s) adds the PATROL Agent resource to one or more 
cluster groups.

Resource Name adds the PATROL Agent service as a Generic 
Service resource type with this name. The 
resource name must be unique for this cluster.
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Service Name creates registry entries for this PATROL Agent 
service name on each node you select. The 
service name must be unique for this system and 
comply with the rules for a service name.
Note: PATROL does not rename the 
PatrolAgent.exe.

Network Name sets the PATROL_VIRTUALNAME_PORT# 
environment variable to this network name, which 
the PATROL Agent uses instead of the host name 
to store the PATROL configuration and history data. 
For easy identification, this name should be the 
virtual server name of the cluster group with which 
the agent is bundled. For example, the network 
name for an agent on port 3182 is 
PATROL_HISTORY_3182=BMC_ExchangeHou.

Port Number sets the port number that the PATROL Agent is 
using and that is referenced by all environment 
variables. Each PATROL virtual Agent must have a 
unique port number.

Shared Drive sets the drive shared by a cluster on which the 
configuration and history data will be stored. The 
PATROL Agent must be able to access this shared 
drive at agent startup, and the shared drive should 
belong to the cluster group with which the PATROL 
Agent is bundled. 

History Path sets the PATROL_HISTORY_PORT# environment 
variable to this path on the shared drive, which 
stores the agent history files. For example, the 
history data location for an agent on port 3182 is 
PATROL_HISTORY_3182=X:\patrol\history.

Config DB Path sets the PATROL_CONFIG_PORT# environment 
variable to this path on the shared drive, which 
stores the PATROL Agent configuration database. 
For example, the configuration database location 
for an agent on port 3182 is 
PATROL_CONFIG_3182=X:\patrol\config.

Node(s) creates a registry entry for the PATROL Agent 
service on each cluster node you select.

Table 4-1 Information Required by PCC

Required 
Information Your Information PCC
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Configuring the PATROL Agent

Action Dialog Notes

1. Click Next.

2. Select the 
appropriate option and 
click Next.

If you are installing the 
first resource, select 
Add one or multiple 
PATROL Agent 
resource(s). Adding a 
PATROL Agent as a 
cluster resource 
performs the following 
actions:
• Sets the required 

environment variables
• Registers the 

PATROL Agent with a 
new service name

• Adds the PATROL 
Agent to the cluster 
as a Generic Service 
resource type and 
sets the resource 
properties
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3. Select the groups to 
which you want to add 
the agent and click 
Next.

You can select multiple 
groups.
In most cases, the 
groups will correspond 
to the applications you 
want to monitor.

4. Enter the appropriate 
information and click 
Node List.

If you do not know what 
names to use, accept 
the defaults. 
The port number must 
be a port that is not in 
use by any other 
process.

Action Dialog Notes
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5. Verify that all nodes 
that you want to 
configure are selected 
and click OK.
You are returned to the 
PATROL Agent 
configuration screen.
Click Next.

You can select or 
deselect nodes by 
clicking on the node. All 
nodes are selected by 
default.

6. Verify the 
configuration 
information and click 
Configure.

Action Dialog Notes
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Your configuration of the PATROL Agent using PCC performs the 
following actions:

• Registers the PATROL Agent service with a new service name within 
the Service Control Manager.

• Sets the registry parameters and port number.
• Sets the service startup to manual.
• Creates the resource of type Generic Service in the cluster.
• Sets the Generic Service resource properties to restart without 

affecting the cluster group; remaining properties have default values.
• Sets the service name parameter of the Generic Service and enables 

use Network Name for computer name.
• Creates PATROL Agent history and configuration files on shared 

disk.
• Creates environment variables for cluster nodes.
• Brings the newly created resource online if the selection box is 

checked.
• Sets resource dependencies on the specified Physical Disk and 

Network Name.

Where to Go Next

Now that you configured the PATROL Agent using PCC, See “Post-PCC 
Configuration” on page 4-10.

7. Click View Log or 
Finish.

You have finished 
configuring the agent. 

Action Dialog Notes
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Post-PCC Configuration

Now that you have finished using PCC to configure multiple PATROL 
Agents, you must perform some post-wizard configuration.

Each of the group agents in the cluster need to monitor resources that are 
a only part of that group. The node agents should not monitor group 
resources. This generally requires using wpconfig to modify the 
disabledKMs list for each group agent, and configuring the remaining 
KMs to monitor only resources that are instances of that group. This also 
means that you only need to modify the preloadedKMs list using 
wpconfig to preload KMs that are appropriate for that node or group 
agent.
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Manually Configuring the PATROL Agent for 
Clustering

Note
BMC Software recommends that you use the PCC Wizard to cluster your 
PATROL Agent. PCC simplifies the configuration process. See “Using 
the PATROL Cluster Configuration Wizard” on page 4-2. However, the 
manual instructions have been included in case you prefer manual 
configuration or want to know what the PCC Wizard is configuring.

The information in this section provides a general idea of the processes 
involved in setting up a Windows cluster environment and integrating 
PATROL into that environment. Procedures and steps describing how to 
set up third-party software are intended as a general outline of the 
process for that product and are not intended as step-by-step instructions.

Setting up PATROL to run in a Windows cluster environment consists of 
several standard tasks. The standard cluster administration tasks and the 
PATROL-specific tasks are described in general terms. This section 
provides a high-level overview of building a Windows cluster and 
integrating PATROL into that environment.

The manual process defined in this chapter requires you to run multiple 
PATROL Agent executables on your CPU if you want to monitor more 
than one application on the cluster.

Install the Application on each Cluster Node

Install the cluster application on the local disk. In the Windows 
environment, the executable must be installed on the local disk.

Install the PATROL Agent on each Cluster Node

Install the PATROL Agent on the local disk of the node. You should have 
at least two separate agent executables installed on the node:
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• one to monitor the node’s operating system
• one to monitor the cluster application

Install the agent once. Include only those Knowledge Modules that 
support the application and the operating system. Then see “Create and 
Register a New Service for the PATROL Agent” on page 4-15 for 
information on setting up a second agent to monitor the cluster 
application.

Assign a Unique Port Number

During installation of the agent on each node, assign a unique, listening 
port number to the PATROL Agent bound to the cluster application. This 
port must be the same across all nodes within the cluster.

Distribute License File

Duplicate the license file on each node. Use the naming convention 
“license” without the host name as an extension. During startup, the 
PATROL Agent searches for “license.hostname,” using its own host 
name. If it can’t find the file, it searches for “license” without an 
extension.

If you duplicate a license file and do not delete or change the file’s host 
name extension, the agent cannot find the license and will not start.

Define the PATROL Cluster-Specific Environment Variables

Create and set the PATROL Cluster-Specific variables. For more 
information, see “Define the PATROL Cluster-Specific Environment 
Variables” on page 4-14.
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Create and Register a New Service for the PATROL Agent

Set up a separate PATROL Agent process that can be bound to the cluster 
application. For more information, see “Create and Register a New 
Service for the PATROL Agent” on page 4-15.

Define the PATROL Agent as a Member of the Group

Associate the PATROL Agent process with the cluster application. For 
more information, see “Define the PATROL Agent as a Member of the 
Group” on page 4-17.
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Define the PATROL Cluster-Specific Environment Variables

Summary: In this task, you will define the PATROL cluster-specific environment 
variables on each node. This action ensures that all the agents in a cluster 
read their configuration information and write their history information 
to the same set of files.

Perform the following tasks on each node in the cluster, then reboot each 
node. Rebooting enables each system to read the new variables and store 
them in memory.

Step 1 From the Windows Taskbar, select Start => Settings => Control Panel.

Step 2 Double-click the System icon and select the Environment tab.

Step 3 Enter the variable name and value in the appropriate fields and click Set. 
The variables and their values are listed below. Repeat this step for the 
remaining variables.

PATROL_VIRTUALNAME_PORT=VirtualServerName
PATROL_HISTORY_PORT=Drive:\History_Directory
PATROL_CONFIG_PORT=Drive:\Config_Directory

For more information about specific variables, see “PATROL 
Cluster-Specific Environment Variables for History and Configuration” 
on page 4-20.
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Create and Register a New Service for the PATROL Agent

Summary: In this task, you will create a PATROL Agent executable and register it as 
a service so that you can dedicate it to monitoring a cluster application. 
This task involves copying and renaming the agent’s executable and then 
registering the service in the Windows Services Applet.

Perform the following task on each node in the cluster.

Step 1 Copy the PatrolAgent.exe in %PATROL_HOME%\bin directory.

Step 2 Rename the executable. Use a name that indicates that the agent is an 
executable dedicated to monitoring an application.

Step 3 Paste the executable into the %PATROL_HOME%\bin directory.

Note
Name the executable the same on every node in the cluster.

PatrolAgent-application_name.exe

Step 4 Install the executable at the command line, navigate to the 
%PATROL_HOME%\bin directory, and enter the following command:

PatrolAgent-application_name -install

The system acknowledges that the service installed successfully.

Tue MON DD HH:MM:SS CCYY PatrolAgent-application_name 
PID 318 Success 1000:
The PatrolAgent Service was successfully installed.
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The PatrolAgent COM Server registered sucessfully

Note
The PatrolAgent COM Server can only be registered once. Additional 
attempts to register it will fail; however, the multiple agent processes will 
run.

Step 5 From the Windows Taskbar, select Start => Settings => Control Panel.

Step 6 Double-click the Services icon and select application_name service from 
the list box. Click Startup.

Step 7 In the Startup Type pane, select the Manual radio button and click OK. 
The service displays Manual in the Startup column.
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Define the PATROL Agent as a Member of the Group

Summary: In this task, you will add the new PatrolAgent service as a resource of 
type “Generic Service” to the cluster. This task is commonly referred to 
as binding the agent to the cluster application.

Note
This task description uses Windows Cluster Management Software as an 
example. The steps describing how to set up the software are intended as 
a general outline of the process and are not intended as step-by-step 
instructions.

Perform the following task on only the master node of the cluster. The 
cluster software provides two methods for binding a service to a cluster: 
GUI or command line. Regardless of which method you choose, you 
must provide the information listed in Table 4-2.

Table 4-2 Cluster Administration Properties (Part 1 of 2)

Arguments Description

cluster.exe Cluster Administration Executable (command line 
only)

clusterName User-defined name of the cluster

RES Specifies the service as a resource of the cluster

"PatrolAgent for 
MyApplication"

Description of the service

/CREATE /Group: 
/TYPE:

Create a group and assign it a resource type.

/ADDEP Establish a dependency between the service and 
the cluster.

/Prop:RestartAction Determines what the cluster does (shut down, wait, 
etc.) if PATROL Agent service fails and is unable to 
restart.

/Priv: ServiceName Identify the service name of the PATROL Agent 
service bound to the cluster application.
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Using Cluster Administration GUI

Add the new PatrolAgent service as a resource of type “Generic Service” 
to the cluster using the Cluster Administrator GUI.

Using the Command Line

To bind a PATROL Agent service to the cluster application, you must 
issue a number of commands. Each command contains the name of the 
cluster registration executable, the name of the cluster, RES, description 
of the service, and various attributes.

Note
For each command, you must reenter the name of the cluster executable, 
the name of the cluster, the resource option, and the service name.

Step 1 Go to the command line.

Step 2 Name the service, designate it as a resource of the cluster, create a group, 
and assign it a resource type of “Generic Service”.

cluster.exe clusterName RES "PatrolAgent for 
MyApplication" /CREATE /Group:MyGroup /TYPE:"Generic 
Service"

Step 3 Add the disk that stores the PATROL Agent configuration and history 
information as a dependency. This command instructs the cluster 
software to bring up the disk with configuration information before it 
attempts to start the PATROL Agent.

/Priv: 
StartupParameters

Specify startup characteristics such as port 
number.

/ON Make the PATROL Agent service available (online) 
to the cluster.

Table 4-2 Cluster Administration Properties (Part 2 of 2)

Arguments Description
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cluster.exe clusterName RES "PatrolAgent for 
MyApplication" /ADDDEP:"Disk MyGroupDisk"

Step 4 Set the restart action. This command determines what the cluster does if 
an application fails and is unable to restart. A value of one (1) indicates 
that if the application is unable to restart, the cluster will continue to run.

cluster.exe clusterName RES "PatrolAgent for 
MyApplication" /Prop:RestartAction=1

Step 5 Identify the service name to the cluster software. The service name must 
be identical to the service name assigned to the PATROL Agent 
executable on each cluster node.

cluster.exe clusterName RES "PatrolAgent for 
MyApplication" /Priv 
ServiceName="PatrolAgent-application_name"

Step 6 Set the port number for the PATROL Agent bound to the cluster 
application. This number must be the same as the number assigned as a 
suffix to the PATROL cluster-specific environment variables.

For details about the PATROL cluster-specific environment variables, see 
“Define the PATROL Cluster-Specific Environment Variables” on page 
4-14.

cluster.exe clusterName RES "PatrolAgent for 
MyApplication" /Priv StartupParameters="-p Port#"

Step 7 Set the service to be available (online) when the cluster is running.

cluster.exe clusterName RES "PatrolAgent for 
MyApplication" /ON
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PATROL Cluster-Specific Environment Variables 
for History and Configuration

To take advantage of failover tolerance for history files, you must create 
and set the value of three environment variables. When creating and 
writing to history files, the PATROL Agent searches for information in 
these files.

Variables

Table 4-3 lists the PATROL cluster-specific environment variables and 
describes their purposes.

Table 4-3 PATROL Cluster-Specific Environment Variables

Environment Variable Description

PATROL_HISTORY
PATROL_HISTORY_PORTa

a To manage multiple PATROL Agents running on separate ports, append the 
port number to the variable name. This situation occurs when individual 
PATROL Agents are bound to individual applications such as Oracle, 
Exchange, Sybase, etc. Each agent uses a separate port number.

the location of history files

If this variable is empty or doesn’t 
exist, the agent writes the history 
files to PATROL_HOME\log\history\ 
host\portnumber.

PATROL_VIRTUALNAME
PATROL_VIRTUALNAME_PORTa

an alias for the host name

If this variable is empty or doesn’t 
exist, the agent uses the host name 
to identify history data within the 
history files.

PATROL_CONFIG
PATROL_CONFIG_PORTa

the location of the configuration 
files

If this variable is empty or doesn’t 
exist, the agent stores the 
configuration file in 
PATROL_HOME\config.
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Operation

When searching for configuration information and creating and writing 
to the history database, the PATROL Agent uses the following logic to 
check for the existence of PATROL cluster-specific variables.

Table 4-4 Operation of Configuration and History Environment Variables

Variable Type Exists? Description

Virtual Name yes PATROL_VIRTUALNAME_8888 exists, the agent writes history 
using the virtual name as the host name. Using the virtual 
name provides continuous history for an application regardless 
of which host the application is running on.

The agent also uses the virtual host name to identify the 
configuration file changes and the history database. 
Configuration file changes are written to 
PATROL_HOME\config\config_virtualname_port.cfg. The 
history database is written to the subdirectory structure 
history\virtualname\port, which will be located in the directory 
pointed to by PATROL_HISTORY_PORT.

no The agent writes history using the actual host name. If the 
application fails over, the agent writes history using the new 
agent’s name. Using the actual hostname creates gaps in the 
results of any dump_hist commands because the command 
does not recognize that the same application ran on different 
hosts.

Configuration File yes PATROL_CONFIG_8888 exists, then the agent reads 
configuration information from the location specified by this 
variable.

no The agent reads from the default directory, 
PATROL_HOME\config\config_virtualname or hostname-port

History Database yes PATROL_HISTORY_8888 exists, then the agent writes history 
to the location specified by this variable

no the agent writes to the default directory, 
PATROL_HOME\log\history\virtualname or hostname\port\
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Example

The following example illustrates how the environment variables would 
be named for a host using port 8888. It also depicts the directory 
structure and file location.

Environment Variables

PATROL_HISTORY=K:\doc\work\histdir
PATROL_VIRTUALNAME=AliasHostName
PATROL_CONFIG=K:\doc\work\config

Directory Structure

For the values provided in the “Environment Variables” section of this 
example, the PATROL Agent stores configuration information and 
records the history data in the following directory structure:

K:\doc\work\histdir\AliasHostName\8888\annotate.dat
K:\doc\work\histdir\AliasHostName\8888\param.hist
K:\doc\work\config\config_AliasHostName-8888

If these variables do not exist or they are empty, the PATROL Agent 
stores configuration information and records the history data in the 
following directory structure:

%PATROL_HOME%\log\history\HostName\8888\annotate.dat
%PATROL_HOME%\log\history\HostName\8888\param.hist
%PATROL_HOME%\config\config_HostName-8888
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Where to Go from Here
The following table suggests topics that you should read next:

If you want information about See

overview of PATROL for Windows Clustering 
components and capabilities

Chapter 1, “Product Components and Capabilities”

how to install PATROL for Windows Clustering Chapter 2, “Installing and Migrating PATROL for 
Windows Clustering”

how to load and configure the PATROL KM for 
Cluster Server or PATROL KM for Network 
Load Balancing using the PATROL Console

Chapter 3, “Loading and Configuring PATROL for 
Windows Clustering KMs”

how to use the PATROL for Windows 
Clustering KMs, and detailed descriptions of 
the applications, menu commands, and 
InfoBoxes

• PATROL KM for Cluster Server online Help or
• PATROL KM for Network Load Balancing online 

Help

parameter descriptions and defaults • PATROL KM for Cluster Server online Help or
• PATROL KM for Network Load Balancing online 

Help or
• PATROL Parameter Reference Manual

accessing menu commands, InfoBoxes, and 
online Help

Appendix A, “Accessing Menu Commands, 
InfoBoxes, and Online Help” 

PATROL Agent configuration variables Appendix B, “Agent Configuration Variables” 
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A

Accessing Menu Commands, 
InfoBoxes, and Online Help A

BMC Software offers several PATROL consoles from which you can 
view a PATROL Knowledge Module (KM). Because of the different 
environments in which these consoles run, each one uses a different 
method to display and access information in the KM. This appendix 
provides instructions for accessing the KM menu commands and 
InfoBoxes. It also provides intructions for accessing the online Help for 
the KM that uses each of the PATROL consoles. See the PATROL KM 
for Microsoft Cluster Server online Help or PATROL KM for Microsoft 
Network Load Balancing online Help for more detailed information 
about navigation in the PATROL Consoles.

Accessing KM Commands and InfoBoxes. . . . . . . . . . . . . . . . . . . . A-2
Accessing Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-3
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Accessing KM Commands and InfoBoxes
Table A-1 provides information about how to access KM commands and 
InfoBoxes from the various PATROL consoles. 

Table A-1 Accessing KM Commands and InfoBoxes 

Console
To access 
menu commands

To access
InfoBoxes

PATROL Classic Console for 
Microsoft Windows–Developer

In either the Desktop tree tab 
or work area, right-click a 
computer or application icon 
and choose KM Commands 
from the pop-up menu.

In either the Desktop tree tab 
or the work area, right-click an 
application class or parameter 
icon and choose InfoBox from 
the pop-up menu.

PATROL Classic Console for 
Unix–Developer

In the work area, right-click a 
computer or application icon to 
display a pop-up menu that 
contains KM-specific 
commands. 

With the middle mouse button, 
click an application class or 
parameter icon.

PATROL Central 
Operator–Microsoft Windows 
Edition

In the navigation pane, 
right-click a managed system or 
applicatiion icon and choose 
Knowledge Module 
Commands from the pop-up 
menu.

In the navigation pane, 
right-click a PATROL object and 
choose InfoBox from the 
pop-up menu.

PATROL Central Operator–Web 
Edition

In the tree view area, right-click 
an application icon and choose 
Knowledge Module 
Commands from the pop-up 
menu.

In the tree view area, right-click 
a PATROL object and choose 
Infobox from the pop-up menu.
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Accessing Online Help

Table A-2 provides information about how to access Help from each 
console.

Note
If you are trying to access Help from a Unix console, see Chapter 2, 
“Installing the Online Help,” for specific instructions about installing and 
setting up a browser in the Unix environment. 

Table A-2 Accessing Online Help (Part 1 of 2)

Console
To access 
product help

To access 
application class 
help

To access 
parameter help

PATROL Classic 
Console for 
Microsoft 
Windows–
Developer

From the console menu 
bar, choose Help => 
Help Topics => 
PATROL Knowledge 
Modules.

Double-click an 
application class in the 
KM tab of the console. 
From the the Application 
Properties dialog box, 
click the Help tab. Then 
click Show Help.

• Right-click a 
parameter icon and 
choose Help On from 
the pop-up menu.

• Double-click a 
parameter icon; click 
the ? icon or Help 
button in the 
parameter display 
window.

• Double-click a 
parameter in the KM 
tab of the console; 
from the properties 
dialog box, click the 
Help tab; then click 
Show Help.

PATROL Classic 
Console for 
Unix–Developer

From the console menu 
bar, choose Help On => 
Knowledge Modules.

Choose Attributes => 
Application Classes 
and double-click the 
application name. Click 
Show Help in the 
Application Definition 
dialog box.

Right-click a parameter 
icon and click Help On.
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PATROL Central 
Operator–Microsoft 
Windows Edition

From the console menu 
bar, choose Help => 
Help Topics. In the 
Contents tab, click the 
name of your product.

In the Operator tab of 
the navigation pane, 
select an application 
icon and press F1.

In the Operator tab of 
the navigation pane, 
select a parameter icon 
and press F1.

PATROL Central 
Operator–Web 
Edition

In the upper right corner 
of PATROL Central, click 
Help and choose 
PATROL KM Help.

In the tree view, 
right-click an application 
class and choose Help.

In the tree view, 
right-click a parameter 
and choose Help.

Table A-2 Accessing Online Help (Part 2 of 2)

Console
To access 
product help

To access 
application class 
help

To access 
parameter help
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B

Agent Configuration Variables B

The variables described in this section are PATROL for Windows 
Clustering variables that are set in the PATROL Agent. Use the agent 
configuration utility to view these variables.

Warning
Changing any of these variables can prevent some functions from 
working properly and affect your entire installation. Make a record of the 
original setting for a variable before you change it.

Managing Configuration Variables. . . . . . . . . . . . . . . . . . . . . . . . . . .B-2
PATROL KM for Cluster Server Configuration Variables. . . . . .B-2
PATROL KM for Network Load Balancing

Configuration Variables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B-5
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Managing Configuration Variables
BMC Software recommends that you set variables by using a console to 
configure PATROL for Windows Clustering KMs. Use the PATROL 
Configuration Manager or the wpconfig utility only to view variable 
settings or deploy them to other machines. 

Warning
Do not use the wpconfig utility or PATROL Configuration Manager to 
remove variables or add new variables. Doing so may prevent some 
functions from working properly and can affect your entire installation.

The PATROL KM for Cluster Server configuration variables are 
described in Table B-1.

Table B-1 PATROL KM for Cluster Server Configuration Variables (Part 1 of 3)

Variable Description

/MCS/AccountInfo stores the Cluster account information

/MCS/applicationClass_AnnotationMode stores the annotation mode setting (On, Off, or 
Error) for the MCS_Groups, 
MCS_Group_Resources, MCS_Nodes, and 
MCS_Performance application classes. The 
annotation mode is set through the PATROL Admin 
=> Configure Annotation Mode menu command.

/MCS/clusterInstance_CluDBBackupPath stores backup path for the Cluster database. The 
path is not set by default, and therefore the 
BackupClusterDatabase parameter is offline. The 
path is set through the Quorum Admin 
(MCS_Quorum) => Set Backup Path menu 
command.

/MCS/clusterInstance_FileShareExclusionList stores excluded file shares. If a file share has been 
excluded, then it will not be monitored by the 
FileShareUnAvailable parameter. Excluded file 
shares are displayed in the Desktop tree and data 
is collected from them by the ResourceStatus 
parameter. You can exclude file shares through the 
PATROL Admin (MCS_Groups) => Maintain 
Exclusion List => Exclude File Shares menu 
command.
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/MCS/clusterInstance_IPExclusionList stores excluded IP addresses. If an IP address has 
been excluded, then it will not be monitored by the 
CheckIPResourceColl parameter. Excluded IP 
addresses are displayed in the Desktop tree and 
data is collected from them by the ResourceStatus 
parameter. You can exclude IP addresses through 
the PATROL Admin (MCS_Groups) => Maintain 
Exclusion List => Exclude IP Address menu 
command.

/MCS/clusterInstance_ResourceExclusionList stores excluded resources. If a resource has been 
excluded, then the resource will not be monitored 
and an instance will not be created. You can 
exclude resources through the PATROL Admin 
(MCS_Groups) => Maintain Exclusion List => 
Exclude Resources menu command.

/MCS/clusterInstance_UpTimeBaseLine stores the start date and time for the 
ClusterAvailability parameter. The date and time is 
set to the current date and time by default. Set the 
start date and time through the PATROL Admin 
(MCS_Cluster) => Set Available Start Date.

/MCS/DomainInclusionList stores the domain name being monitored. To 
monitor an additional domain, you must add a 
variable to the agent’s configuration database using 
wpconfig and a change file. Before loading and 
configuring the KM, a one way trust between the 
domains has to be established. The domain with 
the cluster nodes has to trust the domain with the 
“cluster-level” agent.

Adding a domain:
1. Create a change file as a plain text file using any 
text editor with the following content:
Note: the options of the wpconfig command are 
case sensitive.
PATROL_CONFIG
“/MCS/DomainInclusionList” = { REPLACE 
= “DomainName” }
2. Execute on the command line:
wpconfig +Reload your-filename

Table B-1 PATROL KM for Cluster Server Configuration Variables (Part 2 of 3)

Variable Description
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/MCS/hostName_LogMonKeyAlarm stores keywords that the KM searches for in the 
cluster log file. If any of the keywords are found, the 
ClusterLogFileError parameter sends an alarm. 
Define the keywords through the PATROL Admin 
(MCS_Nodes) => Maintain Keywords menu 
command. By default, no keywords are defined, 
and the parameter is offline.

/MCS/hostName_LogMonKeyDate stores the date from which the KM searches for 
defined keywords in the cluster log file. If any of the 
keywords are found, the ClusterLogFileError 
parameter sends an alarm or warning. Define the 
date and keywords through the PATROL Admin 
(MCS_Nodes) => Maintain Keywords menu 
command. By default, no date or keywords are 
defined, and the parameter is offline.

/MCS/hostName_LogMonKeyWarn stores keywords that the KM searches for in the 
cluster log file. If any of the keywords are found, the 
ClusterLogFileError parameter sends a warning. 
Define the keywords through the PATROL Admin 
(MCS_Nodes) => Maintain Keywords menu 
command. By default, no keywords are defined, 
and the parameter is offline.

/MCS/MenuCmdROMode stores the read-only setting for the Cluster Admin 
Commands. Change the read-only setting through 
the PATROL Admin (MCS_Clusters) => Configure 
Menu Cmd RO Mode menu command. Read-only 
is disabled by default.

/MCS/MonitoredClusterList stores the clusters you are monitoring. Change the 
list through the PATROL Admin (MCS_Clusters) => 
Select Cluster to Monitor menu command.

/MCS/Port stores the port number of the agent on the 
cluster-level agent and the nodes. If you are 
monitoring multiple clusters, the port number must 
be the same. Change the port number through the 
PATROL Admin (MCS_Clusters) => Maintain Port 
Information menu command. The port number is 
3181 by default.

Table B-1 PATROL KM for Cluster Server Configuration Variables (Part 3 of 3)

Variable Description
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The PATROL KM for Network Load Balancing configuration variables 
are described in Table B-2.

Table B-2 PATROL KM for Network Load Balancing Configuration Variables

Variable Description

/LBS/monClusterAndIPList stores the name or IP address of a cluster in the 
following format: name or IP address = IP address 
of the cluster. Change the name or IP address 
through the Manually Add Cluster (LBS_Clusters) 
menu command.

/LBS/monClusterList stores the name or IP address of a cluster (the first 
part of the format: name or IP address = IP address 
of the cluster). Change the name or IP address 
through the Manually Add Cluster (LBS_Clusters) 
menu command.

/LBS/cluster_instance/clusterNodeAndIPList stores the name or IP address of a node in the 
following format: name or IP address = IP address 
of the node. Change the name or IP address 
through the Manually Add a Node (LBS_Cluster) 
menu command.

/LBS/cluster_instance/clusterNodeList stores the name or IP address of a node (the first 
part of the format: name or IP address = IP address 
of the node). Change the name or IP address 
through the Manually Add a Node (LBS_Cluster) 
menu command.

/LBS/cluster_instance/defaultNode stores the default node (default host) of the LBS 
cluster.

/LBS/cluster_name/lastCollectTime stores the last time when the parameter LbsEvtColl 
ran. The value is the number of seconds that have 
elapsed since 00:00:00 GMT, Jan 01, 1970.
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END USER LICENSE AGREEMENT
NOTICE

BY OPENING THE PACKAGE, INSTALLING, PRESSING “AGREE” OR “YES” OR USING THE PRODUCT, THE ENTITY OR
INDIVIDUAL ENTERING INTO THIS AGREEMENT AGREES TO BE BOUND BY THE FOLLOWING TERMS. IF YOU DO NOT
AGREE WITH ANY OF THESE TERMS, DO NOT INSTALL OR USE THE PRODUCT, PROMPTLY RETURN THE PRODUCT TO
BMC OR YOUR BMC RESELLER, AND IF YOU ACQUIRED THE LICENSE WITHIN 30 DAYS OF THE DATE OF YOUR ORDER
CONTACT BMC OR YOUR BMC RESELLER FOR A REFUND OF LICENSE FEES PAID. IF YOU REJECT THIS AGREEMENT, YOU
WILL NOT ACQUIRE ANY LICENSE TO USE THE PRODUCT.   

This Agreement (“Agreement”) is between the entity or individual entering into this Agreement (“You”) and BMC Software Distribution,
Inc., a Delaware corporation located at 2101 CityWest Blvd., Houston, Texas, 77042, USA or its affiliated local licensing entity (“BMC”).
“You” includes you and your Affiliates. “Affiliate” is defined as an entity which controls, is controlled by or shares common control with a
party. IF MORE THAN ONE LICENSE AGREEMENT COULD APPLY TO THE PRODUCT, THE FOLLOWING ORDER OF LICENSE
AGREEMENT PRECEDENCE APPLIES: (1) WEB BASED LICENSE AGREEMENT WITH BMC, (2) WRITTEN LICENSE
AGREEMENT WITH BMC, (3) SHRINK-WRAP LICENSE AGREEMENT WITH BMC PROVIDED WITH THE PRODUCT, AND (4)THIS
ELECTRONIC LICENSE AGREEMENT WITH BMC. In addition to the restrictions imposed under this Agreement, any other usage
restrictions contained in the Product installation instructions or release notes shall apply to Your use of the Product. 

PRODUCT AND CAPACITY. “Software” means the object code version of the computer programs provided, via delivery or electronic
transmission, to You. Software includes computer files, enhancements, maintenance modifications, upgrades, updates, bug fixes, and
error corrections. 

“Documentation” means all written or graphical material provided by BMC in any medium, including any technical specifications,
relating to the functionality or operation of the Software. 

“Product” means the Software and Documentation. 

“License Capacity” means the licensed capacity for the Software with the pricing and other license defining terms, including capacity
restrictions, such as tier limit, total allowed users, gigabyte limit, quantity of Software, and/or other capacity limitations regarding the
Software. For licenses based on the power of a computer, You agree to use BMC’s current computer classification scheme, which is
available at http://www.bmc.com or can be provided to You upon request. 

ACCEPTANCE. The Product is deemed accepted by You, on the date that You received the Product from BMC.

LICENSE. Subject to the terms of this Agreement, as well as Your payment of applicable fees, BMC grants You a non-exclusive,
non-transferable, perpetual (unless a term license is provided on an order) license for each copy of the Software, up to the License
Capacity, to do the following:

(a) install the Software on Your owned or leased hardware located at a facility owned or controlled by You in the country where You
acquired the license; 

(b) operate the Software solely for processing Your own data in Your business operations; and

(c) make one copy of the Software for backup and archival purposes only (collectively a “License”). 

If the Software is designed by BMC to permit you to modify such Software, then you agree to only use such modifications or new
software programs for Your internal purposes or otherwise consistent with the License. BMC grants You a license to use the
Documentation solely for Your internal use in Your operations.

LICENSE UPGRADES. You may expand the scope of the License Capacity only pursuant to a separate agreement with BMC for such
expanded usage and Your payment of applicable fees. There is no additional warranty period or free support period for license
upgrades. 

RESTRICTIONS: You agree to NOT: 

(a) disassemble, reverse engineer, decompile or otherwise attempt to derive any Software from executable code; 

(b) distribute or provide the Software to any third party (including without limitation, use in a service bureau, outsourcing environment,
or processing the data of third parties, or for rental, lease, or sublicense); or

(c) provide a third party with the results of any functional evaluation or benchmarking or performance tests, without BMC’s prior written
approval, unless prohibited by local law.



TRIAL LICENSE. If, as part of the ordering process, the Product is provided on a trial basis, then these terms apply: (i) this license
consists solely of a non-exclusive, non-transferable evaluation license to operate the Software for the period of time specified from BMC
or, if not specified, a 30 day time period (“Trial Period”) only for evaluating whether You desire to acquire a capacity-based license to
the Product for a fee; and (ii) Your use of the Product is on an AS IS basis without any warranty, and BMC, ITS AFFILIATES AND
RESELLERS, AND LICENSORS DISCLAIM ANY AND ALL WARRANTIES (INCLUDING, WITHOUT LIMITATION, THE IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT) AND HAVE NO
LIABILITY WHATSOEVER RESULTING FROM THE USE OF THIS PRODUCT UNDER THIS TRIAL LICENSE (“Trial License”).
BMC may terminate for its convenience a Trial License upon notice to You. When the Trial Period ends, Your right to use this Product
automatically expires.   If You want to continue Your use of the Product beyond the Trial Period, contact BMC to acquire a
capacity-based license to the Product for a fee. 

TERMINATION. This Agreement shall immediately terminate if You breach any of its terms. Upon termination, for any reason, You must
uninstall the Software, and either certify the destruction of the Product or return it to BMC. 

OWNERSHIP OF THE PRODUCT. BMC or its Affiliates or licensors retain all right, title and interest to and in the BMC Product and all
intellectual property, informational, industrial property and proprietary rights therein. BMC neither grants nor otherwise transfers any
rights of ownership in the BMC Product to You. Products are protected by applicable copyright, trade secret, and industrial and
intellectual property laws. BMC reserves any rights not expressly granted to You herein.

CONFIDENTIAL AND PROPRIETARY INFORMATION. The Products are and contain valuable confidential information of BMC
(“Confidential Information”). Confidential Information means non-public technical and non-technical information relating to the
Products and Support, including, without limitation, trade secret and proprietary information, and the structure and organization of the
Software. You may not disclose the Confidential Information to third parties. You agree to use all reasonable efforts to prevent the
unauthorized use, copying, publication or dissemination of the Product.

WARRANTY. Except for a Trial License, BMC warrants that the Software will perform in substantial accordance with the Documentation
for a period of one year from the date of the order. This warranty shall not apply to any problems caused by software or hardware not
supplied by BMC or to any misuse of the Software.

EXCLUSIVE REMEDY. BMC’s entire liability, and Your exclusive remedy, for any defect in the Software during the warranty period or
breach of the warranty above shall be limited to the following: BMC shall use reasonable efforts to remedy defects covered by the
warranty or replace the defective Software within a reasonable period of time, or if BMC cannot remedy or replace such defective copy
of the Software, then BMC shall refund the amount paid by You for the License for that Software. BMC's obligations in this section are
conditioned upon Your providing BMC prompt access to the affected Software and full cooperation in resolving the claim. 

DISCLAIMER. EXCEPT FOR THE EXPRESS WARRANTIES ABOVE, THE PRODUCT IS PROVIDED “AS IS.” BMC, ITS
AFFILIATES AND LICENSORS SPECIFICALLY DISCLAIM ALL OTHER WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT. BMC
DOES NOT WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE, OR THAT
ALL DEFECTS CAN BE CORRECTED.

DISCLAIMER OF DAMAGES. IN NO EVENT IS BMC, ITS AFFILIATES OR LICENSORS LIABLE FOR ANY SPECIAL, INDIRECT,
INCIDENTAL, PUNITIVE OR CONSEQUENTIAL DAMAGES RELATING TO OR ARISING OUT OF THIS AGREEMENT, SUPPORT,
AND/OR THE PRODUCT (INCLUDING, WITHOUT LIMITATION, LOST PROFITS, LOST COMPUTER USAGE TIME, AND DAMAGE
OR LOSS OF USE OF DATA), EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, AND IRRESPECTIVE OF ANY
NEGLIGENCE OF BMC OR WHETHER SUCH DAMAGES RESULT FROM A CLAIM ARISING UNDER TORT OR CONTRACT
LAW. 

LIMITS ON LIABILITY. BMC’S AGGREGATE LIABILITY FOR DAMAGES IS LIMITED TO THE AMOUNT PAID BY YOU FOR THE
LICENSE TO THE PRODUCT.

SUPPORT. If Your order includes support for the Software, then BMC agrees to provide support (24 hours a day/7 days a week)
(“Support”). You will be automatically re-enrolled in Support on an annual basis unless BMC receives notice of termination from You
as provided below. There is a free support period during the one year warranty period. 

(a) Support Terms. BMC agrees to make commercially reasonable efforts to provide the following Support: (i) For malfunctions of
supported versions of the Software, BMC provides bug fixes, patches or workarounds in order to cause that copy of the Software to
operate in substantial conformity with its then-current operating specifications; and (ii) BMC provides new releases or versions, so long
as such new releases or versions are furnished by BMC to all other enrolled Support customers without additional charge. BMC may
refuse to provide Support for any versions or releases of the Software other than the most recent version or release of such Software
made available by BMC. Either party may terminate Your enrollment in Support upon providing notice to the other at least 30 days prior
to the next applicable Support anniversary date. If You re-enroll in Support, BMC may charge You a reinstatement fee of 1.5 times what
You would have paid if You were enrolled in Support during that time period. 

 (b) Fees. The annual fee for Support is 20% of the Software’s list price less the applicable discount or a flat capacity based annual fee.
BMC may change its prices for the Software and/or Support upon at least 30 days notice prior to Your support anniversary date. 



VERIFICATION. If requested by BMC, You agree to deliver to BMC periodic written reports, whether generated manually or
electronically, detailing Your use of the Software in accordance with this Agreement, including, without limitation, the License Capacity.
BMC may, at its expense, perform an audit, at your facilities, of Your use of the Software to confirm Your compliance with the
Agreement. If an audit reveals that You have underpaid fees, You agree to pay such underpaid fees. If the underpaid fees exceed 5% of
the fees paid, then You agree to also pay BMC’s reasonable costs of conducting the audit. 

EXPORT CONTROLS. You agree not to import, export, re-export, or transfer, directly or indirectly, any part of the Product or any
underlying information or technology except in full compliance with all United States, foreign and other applicable laws and regulations.    

GOVERNING LAW. This Agreement is governed by the substantive laws in force, without regard to conflict of laws principles: (a) in the
State of New York, if you acquired the License in the United States, Puerto Rico, or any country in Central or South America; (b) in the
Province of Ontario, if you acquired the License in Canada (subsections (a) and (b) collectively referred to as the “Americas Region”);
(c) in Singapore, if you acquired the License in Japan, South Korea, Peoples Republic of China, Special Administrative Region of Hong
Kong, Republic of China, Philippines, Indonesia, Malaysia, Singapore, India, Australia, New Zealand, or Thailand (collectively, “Asia
Pacific Region”); or (d) in the Netherlands, if you acquired the License in any other country not described above. The United Nations
Convention on Contracts for the International Sale of Goods is specifically disclaimed in its entirety.

ARBITRATION. ANY DISPUTE BETWEEN YOU AND BMC ARISING OUT OF THIS AGREEMENT OR THE BREACH OR
ALLEGED BREACH, SHALL BE DETERMINED BY BINDING ARBITRATION CONDUCTED IN ENGLISH. IF THE DISPUTE IS
INITIATED IN THE AMERICAS REGION, THE ARBITRATION SHALL BE HELD IN NEW YORK, U.S.A., UNDER THE CURRENT
COMMERCIAL OR INTERNATIONAL, AS APPLICABLE, RULES OF THE AMERICAN ARBITRATION ASSOCIATION. IF THE
DISPUTE IS INITIATED IN A COUNTRY IN THE ASIA PACIFIC REGION, THE ARBITRATION SHALL BE HELD IN SINGAPORE,
SINGAPORE UNDER THE CURRENT UNCITRAL ARBITRATION RULES. IF THE DISPUTE IS INITIATED IN A COUNTRY
OUTSIDE OF THE AMERICAS REGION OR ASIA PACIFIC REGION, THE ARBITRATION SHALL BE HELD IN AMSTERDAM,
NETHERLANDS UNDER THE CURRENT UNCITRAL ARBITRATION RULES. THE COSTS OF THE ARBITRATION SHALL BE
BORNE EQUALLY PENDING THE ARBITRATOR’S AWARD. THE AWARD RENDERED SHALL BE FINAL AND BINDING UPON
THE PARTIES AND SHALL NOT BE SUBJECT TO APPEAL TO ANY COURT, AND MAY BE ENFORCED IN ANY COURT OF
COMPETENT JURISDICTION. NOTHING IN THIS AGREEMENT SHALL BE DEEMED AS PREVENTING EITHER PARTY FROM
SEEKING INJUNCTIVE RELIEF FROM ANY COURT HAVING JURISDICTION OVER THE PARTIES AND THE SUBJECT MATTER
OF THE DISPUTE AS NECESSARY TO PROTECT EITHER PARTY’S CONFIDENTIAL INFORMATION, OWNERSHIP, OR ANY
OTHER PROPRIETARY RIGHTS. ALL ARBITRATION PROCEEDINGS SHALL BE CONDUCTED IN CONFIDENCE, AND THE
PARTY PREVAILING IN ARBITRATION SHALL BE ENTITLED TO RECOVER ITS REASONABLE ATTORNEYS’ FEES AND
NECESSARY COSTS INCURRED RELATED THERETO FROM THE OTHER PARTY. 

U.S. GOVERNMENT RESTRICTED RIGHTS. The Software under this Agreement is “commercial computer software” as that term is
described in 48 C.F.R. 252.227-7014(a)(1). If acquired by or on behalf of a civilian agency, the U.S. Government acquires this
commercial computer software and/or commercial computer software documentation subject to the terms of this Agreement as
specified in 48 C.F.R. 12.212 (Computer Software) and 12.211 (Technical Data) of the Federal Acquisition Regulations (“FAR”) and its
successors. If acquired by or on behalf of any agency within the Department of Defense (“DOD”), the U.S. Government acquires this
commercial computer software and/or commercial computer software documentation subject to the terms of this Agreement as
specified in 48 C.F.R. 227.7202 of the DOD FAR Supplement and its successors.

MISCELLANEOUS TERMS. You agree to pay BMC all amounts owed no later than 30 days from the date of the applicable invoice,
unless otherwise provided on the order for the License to the Products. You will pay, or reimburse BMC, for taxes of any kind, including
sales, use, duty, tariffs, customs, withholding, property, value-added (VAT), and other similar federal, state or local taxes (other than
taxes based on BMC’s net income) imposed in connection with the Product and/or the Support. This Agreement constitutes the entire
agreement between You and BMC and supersedes any prior or contemporaneous negotiations or agreements, whether oral, written or
displayed electronically, concerning the Product and related subject matter. No modification or waiver of any provision hereof will be
effective unless made in a writing signed by both BMC and You. You may not assign or transfer this Agreement or a License to a third
party without BMC’s prior written consent. Should any provision of this Agreement be invalid or unenforceable, the remainder of the
provisions will remain in effect. The parties have agreed that this Agreement and the documents related thereto be drawn up in the
English language. Les parties exigent que la présente convention ainsi que les documents qui s’y rattachent soient rédigés en anglais.
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